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1 Models for continuous outcomes 

1.1 Models based on a subset of the NESARC data 

1.1.1 The data 

The data set is from the National Epidemiologic Survey on Alcohol and Related 
Conditions (NESARC), a longitudinal survey with its first wave fielded in 2001-2002. 
The NESARC is a representative sample of the United States population, and 43,093 
Americans participated in the first wave of the survey. The NESARC survey was 
conducted and sponsored by the National Institute on Alcohol Abuse and Alcoholism 
(NIAAA). Detailed information is available at http://niaaa.census.gov/index.html.  

 

Section 4 of the NESARC data documentation describes data regarding major 
depression, family history of major depression and dysthymia. Together with the 
demographic information in Section 1, we produced the nesarc_ll2.xls data set as 
shown below. There are 2,339 dysthymia respondents in the survey. After listwise 
deletion, the sample size is 1,698. 

 

 
 

http://niaaa.census.gov/index.html
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The variables of interest are: 

o PSU is the Census 2000/2001 Supplementary Survey (C2SS) primary 
sampling unit (PSU). 

o WEIGHT is the final weight, calculated as the product of the NESARC base 
weight and other individual weighting factors. 

o WHITEOTH represents the white and other ethnicities, excluding African 
American and Hispanic. It is recoded from items S1Q1C, S1Q1D2, S1Q1D3 
and S1Q1D5 in the NESARC source code (1 for white and other, 0 for African 
American and Hispanic). 

o BLACK represents African Americans. It is recoded from items S1Q1C and 
S1Q1D3 in the NESARC source code (1 for African American, 0 for others). 

o HISPANIC is an indicator for Hispanic. It is recoded from items S1Q1C, 
S1Q1D3 and S1Q1D5 (1 for Hispanic, 0 for others). 

o M_S_DEP is recoded from item S4BQ10C. It is the response to the statement 
“Any of natural mother’s full sisters ever depressed,” with 1 for “Yes,” and 
0 for “No.” 

o ARG_DEP is recoded from item S4CQ43. It represents the response to the 
statement “Had arguments/friction with family, friends, people at work, or 
anyone else,” with 1 for “Yes,” 0 for “No.” 

o AGE_DEP is a renamed version of item S4CQ7AR. It represents the age at 
onset of first episode of dysthymia. 

Inspection of the data shows that only about 2% of 43,093 respondents are of Asian 
and Pacific origin. Due to the skewness of the distribution of ethnicity, we recoded 
the variables representing ethnic origin. The resulting variable WHITEOTH represents 
this recoding of respondents as being either white or from other ethnic groups 
(blacks and Hispanics excluded).  

1.1.1.1 Importing the data and defining variable types 

The data set shown previously is available  in the form of a spreadsheet file, named 
nesarc_ll2.xls. This file contains a subset of the original NESARC data, i.e. data for 
the 1,698 respondents who reported some form of depression and for whom 
complete information on variables of interest was available.  
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The first step is to create the SuperMix spreadsheet file (*.ss3) from the Excel file:  

o  Use the Import Data File option on the File menu to load the Open dialog 
box.  

o Browse for the file nesarc_ll2.xls in the examples folder of the SuperMix 
installation folder.  

o Select the file and click on the Open button to open the following SuperMix 
spreadsheet window nesarc_ll2.ss3. 

 

 
 

Note that row 1 of the spreadsheet contains the variable labels. To rename the 
column headers to reflect the variables contained in each column, first left-click on 
the row 1 tab to select the complete row and then right-click and select the Create 
Headers from Row option from the pop-up menu as shown below. 

 

 
 

The spreadsheet headers now correspond to the names shown in the first row of the 
spreadsheet. This row is no longer needed, and is deleted by right-clicking anywhere 
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on row 1 and then selecting the Delete Row option from the pop-up menu as 
illustrated below 

 

 
 

to produce the following SuperMix spreadsheet window. 

 

 
 

Next, we define the variable types. Highlight WHITEOTH by clicking on the variable 
name, and then right click to open the following pop-up menu. Select the Column 
Properties option  
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to open the Column Properties dialog box. Checking the Nominal radio button 
enables the user to define the labels. Input correct labels for the different categories 
as shown below. 

 

 
 

Similarly define BLACK, HISPANIC, M_S_DEP and ARG_DEP as nominal variables 
and define AGE_DEP as continuous.  

 

To save the nesarc_ll2.ss3 spreadsheet, select the Save As option from the File menu 
to load the Save As Spreadsheet Data dialog box, and then enter the desired file 
name in the File name string field as shown below. Click on the Save button when 
done.  
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1.1.1.2 Exploring the data 

Graphics are often a useful data-exploring technique through which the researcher 
may familiarize her- or himself with the data. Relationships and trends may be 
conveyed in an informal and simplified visual form via graphical displays. SuperMix 
offers both data-based and model-based graphs. Data-based graphing options are 
accessed via the File, Data-based Graphs option once a SuperMix data file (.ss3) is 
opened, and include Exploratory, Univariate, Bivariate and Multivariate graphs as 
shown on the pop-up menu below. Model-based graphs are available after the 
analysis has been performed, and will be discussed later in this section. 

 

In the case of data-based graphs, we distinguish between three categories: 
univariate, bivariate, and multivariate graphs. Univariate graphs are particularly 
useful to obtain an overview of the characteristics of a variable. However, they do 
not necessarily offer the tools needed to explore longitudinal data as completely as 
one would wish. For that purpose, bivariate and multivariate data-based graphs are 
more appropriate. 
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Univariate graphs 

The pop-up menu below shows the data-based graphing options currently available 
in SuperMix. As a first step, we take a look at the distribution of age at onset of first 
depression episode (AGE_DEP), which is the potential dependent variable in this 
study.  

Histograms 

A histogram represents the frequency of cases per unit interval. It gives a good 
picture of the distribution of a variable. To create a histogram for AGE_DEP, select 
the Univariate option from the Data-based Graphs menu as shown below. 

 

 
 

The Univariate plot dialog box appears. Select the variable AGE_DEP and indicate 
that a Histogram is to be graphed. The desired number of intervals shown on the 
histogram is controlled by the Number of class intervals field. It is specified as 18 in 
this case. Click the Plot button to display the histogram. 
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The histogram, as seen below, shows that the distribution of AGE_DEP is nearly 
symmetrical, and should satisfy the normality assumptions implicit in a multilevel 
model.  

 

 
Figure XXX.1: Histogram of the variable AGE_DEP
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1.1.2 2-level random intercept model with 2 predictors 

1.1.2.1 The model 

A two-level multilevel model consists of two submodels, one at each level of the 
hierarchy. A general two-level model for a continuous response variable y  

depending on a set of p  predictors 1 2 rx , x , ,x  can be written in the form 

 

 ' '
ij ij ij i ijy   x â z v  

 

where 1 2i , , , N   denotes the level-2 units, and 1 2 ij , , , n   the level-1 units. 

In this context, ijy  represents the response of individual j , nested within level-2 

unit i . The model shown here consists of a fixed and a random part. The fixed part 
of the model is represented by the vector product '

ijx â , where '
ijx  is a typical row of 

the design matrix of the fixed part of the model with, as elements, a subset of the p  
predictors. The vector â  contains the fixed, but unknown parameters to be 

estimated. '
ij iz v  and ij  denote the random part of the model at levels 2 and 1 

respectively. For example, '
ijz  represents a typical row of the design matrix of the 

random part at level 2, and iv  the vector of random level-2 effects to be estimated. 

It is assumed that 01 02 0 Nv ,v , ,v  are independently and identically distributed (i.i.d.) 

with mean vector 0  and covariance matrix (v) . Similarly, the ij  are assumed 

i.i.d., with mean 0 and variance 2 . 

 

The first model fitted to the NESARC data explores the relationship between 
AGE_DEP and the maternal-side depression and argument involvement, as 
represented by the variables M_S_DEP and ARG_DEP. The level-1 model is at a 
patient level, while the level-2 model is at a PSU level. The model can be expressed 
as 
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Level-1 model:  

 

   0 1 2AGE_DEP MS_DEP ARG_DEPij i i i ijij ij
b b b e       

 

Level-2 model: 

0 0 0

1 1

2 2

i i

i

i

b v

b

b





 




 

where  

 
 

20,

0,

i i

i i

N

N

  I

v Ó




 

 

0  denotes the average expected age at onset of the first episode and 1  denotes the 

coefficient of the predictor variable M_S_DEP (slope) in the fixed part of the model. 
Given that the variable M_S_DEP is an indicator variable, 1  is in effect the 

expected change in age at onset for patients who reported maternal-side depression. 
Likewise, 2  is in effect the expected change in age at onset for patients who 

reported arguments and stress. The random coefficients 0iv  and ije  denote the 

variation in the average expected AGE_DEP value between PSUs and between 
patients respectively.  

 

The model can also be written in so-called mixed model notation, as shown below. 

 

0 1 2 0AGE_DEP M_S_DEP ARG_DEPij ij ij i ijv e          
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1.1.2.2 Setting up the analysis 

Open the SuperMix spreadsheet nesarc_ll2.ss3 used during the exploratory analysis 
discussed previously. The next step is to describe the model to be fitted. We use the 
SuperMix interface to provide the model specifications. From the main menu bar, 
select the File, New Model Setup option.  

 

 
 

The Model Setup window that appears has six tabs. In this example, only the screens 
associated with the first two tabs are used. Information entered on these tabs are 
subsequently saved to a syntax file (*.mum) that can be retrieved later as needed. 

 

The Configuration screen is the first tab on the Model Setup window. It enables the 
user to define the outcome variable, level-2 and level-3 IDs. Some other settings 
such as missing values, the convergence criterion, the number of iterations, etc. can 
be specified here. For all the available settings, please refer to chapter XXXX. To 
obtain the model we discussed, proceed as follows. 

o Select the continuous outcome variable AGE_DEP from the Dependent 
Variable drop-down list box.  

o Select PSU from Level-2 ID drop-down list box.  

o Enter a title for the analysis in the Title text boxes (optional).  
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o Keep all the other settings on the Configuration screen at their default values. 
Proceed to the Variables screen by clicking on that tab. 

 

  
 

The Variables screen is used to specify the fixed and random effects to be included 
in the model. This screen shows the list of variables available for analysis and next 
to it two columns, with headings E (for explanatory variables) and 2 (for level-2 
random effects). 

o Select the explanatory (fixed) variables by checking the E check boxes next 
to the variables M_S_DEP and ARG_DEP in the Available grid at the left of 
the screen. Note that, as the variables are selected, they are listed in the 
Explanatory Variables grid.  

o After selecting all the explanatory variables, the screen shown below is 
obtained.  

 

Note that the Include Intercept check boxes in the Explanatory Variables grid and L-2 
Random Effects grid are checked by default, indicating that an intercept term will 
automatically be included in the fixed and random parts of the model.  
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Before running the analysis, the model specifications have to be saved. Select the 
File, Save As option, provide a name (nesarc_ll2.mum) for the model specification 
file, and save. 
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Run the analysis by selecting the Run option from the Analysis menu. The standard 
output file opens. It can also be viewed by selecting the View Output option from the 
same menu.  

 

 

1.1.2.3 Discussion of results 

Portions of the output file nesarc_ll2.out are shown below.  

Program information and syntax 

At the top of the output file, program information is given. It states the type, date 
and time of analysis, and provides contact information for technical support.  
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Program information is followed by model specifications. This section echoes the 
contents of the syntax file nesarc_ll2.mum. For more information on syntax and 
keywords, please see Section XXX. 

 

 

Data summary 

 
 

In the next section of the output file as shown above, a description of the 
hierarchical structure of the data is provided. Data from a total of 371 PSUs and 
1,698 respondents were included at levels 2 and 1 of the model. In addition, a 
summary of the number of respondents nested within each PSU is provided. For 
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example, the PSU with N2:14 had 15 respondents. Note that N2:2 had only 1 
observation, which means that the estimation for this PSU might not be reliable. 

Descriptive statistics and starting values 

The data summary is followed by descriptive statistics for all the variables included 
in the model. We note that the observed average age at the onset of depression is 
approximately 31 years. 

 

  
 

Descriptive statistics are followed by the starting values of the parameters that were 
used in the initial step of the iterative algorithm. These starting values are obtained 
by ordinary least squares (OLS) regression, which calculates the estimates by 
minimizing the sum of the squares of the residuals. 

 

The  starting values for the fixed regressor(s) are shown below. The log likelihood 
value and number of free parameters of the OLS regression are given in this part 
of the output. 
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The  starting values for the random effects are given next. 

 

 

Fixed effects results 

The output describing the estimated fixed effects after convergence is shown next. 
The estimates are shown in the column with heading Estimate, and correspond to the 
coefficients 0 1,   and 2  in the model specification. From the z-values and 

associated exceedance probabilities, we see that all three estimates are highly 
significant.  
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The estimated intercept is 37.472, which means that the average age of the first 
episode onset of the dysthymia respondents who do not have mother-side depression 
history and don’t argue with others is around 37.4. The estimated coefficients 
associated with the mother-side history of depression (M_S_DEP) is – 4.898, which 
indicates that the respondents who have maternal-side depression history tend to get 
the first episode about five years earlier than those who do not (given the same 
response on ARG_DEP). The estimate for the indicator of argument involvement 
(ARG_DEP) shows that a respondent who has argument(s) with others is likely to 
have a first episode of depression about eight years earlier than a respondent who 
did not report arguing.  

Fit statistics  

In addition to the likelihood function value at convergence, a number of related 
statistical measures for assessing model adequacy are available. The most common 
of these are the likelihood ratio test and Akaike's and Schwarz's criteria. Both the 
Akaike information criterion (AIC) and the Schwarz Bayesian criterion (SBC) are 
functions of the number of estimated parameters, and therefore "penalize" models 
with large numbers of parameters. In the SuperMix output file, all three of these are 
reported. A chi-square scale factor, with which a chi-square value obtained from the 
difference between two deviance statistics should be multiplied to yield a corrected 
chi-square statistic in the case of a weighted analysis, may also be found in this 
section. 
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o The deviance is defined as 2ln L . For a pair of nested models, the 
difference in 2ln L  values has a 2  distribution, with degrees of freedom 
equal to the difference in number of parameters estimated in the models 
compared.  

o The AIC was originally proposed for time-series models, but is also used in 
regression. It is defined as 2ln 2L r  , where r  denotes the number of 
parameters estimated in the model. The model with minimum AIC, in a set of 
nested models, will be the most parsimonious according to this criterion. 

o The SBC is defined as 2ln logL r n  , where n  denotes the number of units 
at the highest level of the hierarchy. A smaller value of this criterion would 
indicate the most parsimonious of the models being compared.  

Random effects results 

The output for the random part of the model follows, and is shown in the image 
below. In the case of a model with only a random intercept, there are two variances 
of interest: the variation in the random intercept over the patients, and the residual 
variation at level 1 over the measurements. There is no significant variation in the 
average estimated AGE_DEP at level 2 ( p =0.33). This indicates that the expected 
average age at onset of depression does not differ significantly from PSU to PSU 
(the level-2 units). Significant differences between the patients (the level-1 units) 
are reported ( p =0.00). 
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1.1.2.4 Interpreting the results 

Model-based graphs 

Activate the Model Setup window by clicking on it. Using the Plot Equations for: 
AGE_DEP dialog box that appears when the File, Model-based Graphs, Equations 
option is selected, we can graphically depict the trend in expected age at onset of 
depression, taking the values of the predictors M_S_DEP and ARG_DEP into account. 
The dialog box below shows the selection of the predictor M_S_DEP. Marking of the 
plots by ARG_DEP is also requested. Two graphs will thus be displayed on the same 
set of axes: one for each value of the indicator variable ARG_DEP. By default, all 
variables present in the model, but not selected for inclusion in the graph, will be 
assumed to have a value of 0.  
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The graph below shows the result obtained when the Plot button is clicked after 
completion of the Plot Equations for: AGE_DEP dialog box as shown above. We note 
that patients who did not report arguing are expected to experience onset 
approximately 8 years later than patients reporting involvement in arguments.  

 

   
Figure XXX.3: Plot of AGE_DEP versus M_S_DEP for 2 groups 
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A similar plot for the predictor ARG_DEP is given next. This graph was obtained by  
swapping the positions of the M_S_DEP and ARG_DEP variables on the Plot 
Equations for: AGE_DEP dialog box. Note that patients with maternal-side 
depression had their first episode approximately 5 years earlier than patients with no 
history of maternal-side depression. The two graphs shown represent the graphic 
interpretation of the fixed effect estimates shown previously. 

 

 
Figure XXX.4: Plot of AGE_DEP versus M_S_DEP for 2 groups 

ICCs and % variance explained 

By calculating the total variation in the age at onset as explained by the current 
model, we can obtain an estimate of the intracluster correlation coefficient. We first 
need to calculate the total variation in the outcome variable, which for this model is 

defined as  
0var( ) var( )ij ie v . 
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The intracluster coefficient is then defined as 

 

 


 
0

0

var( )

var( ) var( )
i

ij i

v
ICC

e v



 

 

and represents the proportion of variation in age at onset that is between the groups 
(PSUs). An estimate of the percentage of variation in the outcome at a PSU level is 
obtained as 

 
2.78918

100% 1.29%
2.78918 213.07164 

 


 

 

indicating that only 1.29% of the total variance is explained at PSU level; the rest of  
the variance remains at the respondent level.  

1.1.3 A 2-level random intercept model with 4 predictors  

1.1.3.1 The model 

In the previous section, we modeled the outcome variable AGE_DEP as a function of  
M_S_DEP and ARG_DEP. The extended model discussed in this section takes the 
ethnicity of a respondent into consideration. The model fitted is expressed as 
follows: 

 

0 1 2

3 4 0

AGE_DEP BLACK HISPANIC

M_S_DEP ARG_DEP .
ij ij ij

ij ij i ijv e

  

 

    

     
 

 

As before, 0  denotes the average expected age at the onset of first episode, 

1 2 4, , ,    indicate the estimated coefficients associated with the fixed part of the 

model, and 0iv  and ije  represent the random part of the model.  
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Recall from Section XXX that ethnicity was represented by 3 indicator variables, 
namely WHITEOTH, BLACK and HISPANIC. In the model formulated above, only two 
of these variables have been included. This was done since the inclusion of all three 
indicators and the intercept term in the model would cause collinearity between the 
fixed effects. Any of the respondents will have a value of "1" on one of the three 
ethnicity indicators. If the values of the indicators are added together in a column-
wise fashion, a column of 1s will result. The intercept variable is represented by just 
such a column of 1s in the program. If a linear combination of a subset of the 
columns of the design matrix is a constant multiple of another column, a condition 
referred to as multicollinearity is present and the model cannot be estimated 
properly. 

 

Consider an example where three respondents, one from each of the three ethnic 
groups, are considered: 

 
 Patient WHITEOTH     BLACK   HISPANIC Sum of Ethnicity var.       Intercept 

  1 1  0  0  1   1 

 2 0  1  0  1   1 

 3 0  0  1  1   1 

 

There are two ways in which the model can be formulated to avoid running into this 
problem. The first is to exclude the intercept and use only the three ethnicity 
indicators. Such a model, as shown below, 

 

0 1 2

3 4 0

AGE_DEP WHITEOTH BLACK HISPANIC

M_S_DEP ARG_DEP
ij ij ij ij

ij ij i ijv e

  

 

     

     
 

 

would not offer an estimated coefficient of the average age at onset. Instead, the 
expected average age at onset for each of the three ethnic groups may be deduced 
from the estimated coefficients for WHITEOTH, BLACK and HISPANIC. 
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Alternatively, one can drop one of the ethnicity indicators from the model while 
retaining the intercept coefficient. This is what we have opted to do in the current 
example: 

0 1 2

3 4 0

AGE_DEP BLACK HISPANIC

M_S_DEP ARG_DEP
ij ij ij

ij ij i ijv e

  

 

    

     
 

 

In the case of this formulation, the intercept coefficient represents the expected 
average age at onset for a patient with a value of zero on all the predictors. But if the 
indicators BLACK and HISPANIC assume a value of 0, it implies that the remaining 
ethnicity variable WHITEOTH must have a value of 1. As a result, the interpretation 
of the intercept coefficient would be the expected average onset age for a patient 
who is white or from some other ethnic origin (excluding African American and 
Hispanic). This ethnic group thus becomes the reference group in the current 
analysis. Any of the ethnic groups can be used as the reference group by simply 
adjusting the coding of the indicator variables; the only proviso being that the group 
of interest have sufficient data to serve as stable reference group. 

1.1.3.2 Setting up the analysis 

The SuperMix spreadsheet nesarc_ll2.ss3 and the model specification file 
nesarc_ll2.mum discussed in the previous example are used a point of departure.  

 

 



 
 
 

32 
 

With the model specification file open, click on the Variables tab of the Model Setup 
window. Add the predictors BLACK and HISPANIC to the model by checking the 
boxes next to these variables in the E column, as shown above. 

 

Save the modified model specification file, and select the Run option from the 
Analysis menu to perform the analysis. 

1.1.3.3 Discussion of results  

Fixed effects results 

The maximum likelihood estimates of the coefficients in the fixed part of the model 
are shown below. Statistically the estimate for HISPANIC is not significant 
( p =0.61). Both estimates for BLACK and HISPANIC are negative, which indicates 
that African American and Hispanic respondents tend to have an earlier onset of the 
first episode when compare with patients from white and other ethnic groups. 

 

 

 

Fit statistics  

Fit statistics for the current model are reported as shown below. 

 



 
 
 

33 
 

 

Random effects results 

The output for the random part of the model is given next.  

 

 
 

The random intercept effect at level 2 is not significant. As before, most of the 
variation in scores is found at a respondent level, with only about 2% of the 
variation remaining at the PSU level. 

1.1.3.4 Interpreting the results 

Estimated outcomes for different groups 

The estimated outcome for any patient can be obtained using the formula 

 

    


0 1 2 3

4 0

AGE_DEP BLACK HISPANIC M_S_DEP

ARG_DEP

ij ij ijij

ij i ijv e

   



      

   
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For a white respondent, the expected AGE_DEP can be calculated as 

 

   
0 3 4AGE_DEP M_S_DEP ARG_DEP

38.04388 4.90955 M_S_DEP 8.15043 ARG_DEP .

ij ijij

ij ij

      

    
 

 

For African American respondents BLACK = 1, and thus the formula used to predict 
their AGE_DEP scores reduces to 

 

    
0 1 3 4AGE_DEP BLACK M_S_DEP ARG_DEP

38.04388 2.50738 1 4.90955 M_S_DEP 8.15043 ARG_DEP .

ij ij ijij

ij ij

         

      
 

 

The formula for a patient of Hispanic origin can be derived in a similar way. In 
Table XXX.1, the same expected ages of the first episode onset for different groups 
are calculated based on the formulas above. 

  

Table XXX.1: Expected AGE_DEP for various groups of patients 

 

Origin M_S_DEP = No 
ARG_DEP = No 

M_S_DEP = Yes 
ARG_DEP = No 

M_S_DEP = No 
ARG_DEP = Yes 

M_S_DEP = Yes 
ARG_DEP = Yes 

White & Other 38.04 33.13 29.89 24.98 

African American 35.54 30.63 27.39 22.48 

Hispanic 37.50 32.59 29.35 24.44 

 

The results show that the respondent who has a history of maternal-side depression 
or gets involved into arguments generally has an earlier onset age for the first 
episode. For the respondents with the same M_S_DEP and ARG_DEP values, the 
average first episode onset ages of African American respondents are the lowest. 
We also conclude that a patient involved in arguments (ARG_DEP = 1) is likely to 
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have an earlier onset age of depression than a patient with maternal-side depression 
only (M_S_DEP = 1). 

Fit statistics and % variation explained 

The table below shows the fit indices for the previous and current models. 

 

TABLE XXX.2: Comparison of random intercept models for NESARC data 
 

Fit indices Model with 2 
indicators 

Model with 4 
indicators Difference 

Log Likelihood -6971.8161 –6968.6728  
–2 Log Likelihood (Deviance) 13943.6321 13937.3456 6.2865 
Akaike's Information Criterion 13953.6321 13951.3456 2.2865 
Schwarz's Bayesian Criterion 13973.2131 13978.7591 –5.5460 
Number of free parameters 5 7  

 

The difference in deviances can be used to assess the model fit. This method is valid 
for nested models. A nested model may be defined as any submodel of a given 
model that is based on the same number of observations. Given the difference in 
structure between the 2-level models these models cannot, however, be compared to 
each other.  

 

The difference in the deviances follows a 2 distribution, where the degree of 
freedom is the difference of numbers of free parameters.  

 

        22ln 2ln ~ . . 2 ln 2lnmodel1 model2 model2 model1d f     
 

 

When the deviances of the two models are compared, a 2 -statistic of 13943.6321 
– 13937.3456 = 6.2865 with 7 – 5 = 2 degrees of freedom is obtained. This indicates 
that the current model fits the data better. The AIC decreased from 13953.6321 to 
13951.3456, and also favors the use of the 4-predictor model. The SBC, however, 
increased slightly, from 13973.2131 to 13978.7591, and thus favors the model 



 
 
 

36 
 

previously fitted as the more parsimonious. The definitions of these indices are 
given in the discussion of the output of the previous model. Note, however, that the 
changes in all three criteria are rather small. 

 

The estimated percentages of variation in outcome at respondent level can be 
calculated using the variance components reported in the random effects part of the 
output file:  

 
211.80901

100% 98.46%
211.80901  3.31353 

 


. 

 

Once the additional level-1 predictors are taken into account, there does not seem to 
be significant random variation in the outcome over the intercepts of the level-2 
units. The estimated average onset age of the first episode does not vary 
significantly from PSU to PSU.  
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1.2 Models based on the Reisby data 

1.2.1 The data 

The data set is from a study described in Reisby et. al. (1977) that focused on the 
longitudinal relationship between imipramine (IMI) and desipramine (DMI) plasma 
levels and clinical response in 66 depressed inpatients (37 endogenous and 29 non-
endogenous). Following a placebo period of 1 week, patients received 225 mg/day 
doses of imipramine for four weeks. In this study, subjects were rated with the 
Hamilton depression rating scale (HDRS) twice during the baseline placebo week (at 
the start and end of this week) as well as at the end of each of the four treatment 
weeks of the study. Plasma level measurements of both IMI and its metabolite DMI 
were made at the end of each week. The sex and age of each patient were recorded 
and a diagnosis of endogenous or non-endogenous depression was made for each 
patient.  

 

Although the total number of subjects in this study was 66, the number of subjects 
with all measures at each of the weeks fluctuated: 61 at week 0 (start of placebo 
week), 63 at week 1 (end of placebo week), 65 at week 2 (end of first drug treatment 
week), 65 at week 3 (end of second drug treatment week), 63 at week 4 (end of third 
drug treatment week), and 58 at week 5 (end of fourth drug treatment week). The 
sample size is 375. Data for the first 10 observations of all the variables used in this 
section are shown below in the form of a SuperMix spreadsheet file, named 
reisby.ss3. 
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The variables of interest are: 

 

o Patient is the patient ID (66 patients in total). 

o HDRS is the Hamilton depression rating scale. 

o WEEK represents the week (0, 1, 2, 3, 4 or 5) at which a measurement was 
made. 

o WEEKSQ represents the squared values of WEEK. The creation of this 
variable is illustrated in Section 1.2.5.2. 

o ENDOG is a dummy variable for the type of depression a patient was 
diagnosed with (1 for endogenous depression and 0 for non-endogenous 
depression). 

o WxENDOG represents the interaction between WEEK and ENDOG, and is the 
product of WEEK and ENDOG. 

1.2.1.1 Exploring the data 

Graphing the observed data 

In the previous example, we have shown a number of data-based graphs. Here, we 
use the Exploratory option of the Data-Based Graphs menu to explore the data in the 
reisby.ss3 spreadsheet, stored in the Continuous subfolder.  

 

Start by opening the data file in the SuperMix spreadsheet. Then select the Data-
based Graphs, Exploratory option on the File menu as shown below to activate the 
New Graph dialog box. 
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Specify HDRS as the dependent (vertical axis) variable by selecting it from the Y 
drop-down list box and WEEK as the independent (horizontal axis) variable by 
selecting it from the X drop-down list box. A graph on the same axis system is 
created for each patient by selecting the variable Patient from the Overlay drop-down 
list box. Furthermore, each graph is assigned a color by selecting ENDOG from the 
Color drop-down list box to produce the following New Graph dialog box.  
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Click on the OK button to produce the following graph of the reaction trajectories 
over time for the 66 inpatients. 

 

 
Figure XXX.5: Reaction trajectories over time for 66 patients 

 

To modify the existing graphic display, select the Edit Graph option from the 
Settings menu to load the Edit Graph dialog box. To obtain different graphs for the 
two categories of the covariate ENDOG, select it from the Filter drop-down list box 
to produce the following Edit Graph dialog box. 
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Click on the OK button to open the following graphics window. 

 

 
Figure XXX.6: Reaction trajectories over time for patients with ENDOG=0 

 

At the bottom of the graphics window is a "slider" with left and right arrows. By 
clicking on the right arrow, one can obtain the next graphic shown below and by 
clicking on the left arrow, the graphic above. 

 

 
Figure XXX.7: Reaction trajectories over time for patients with ENDOG=1 
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The above graphs show a general, approximately linear decline over time and an 
increase in the variability of the HDRS scores across time for both types of 
depression.  

1.2.2  A 2-level random intercept-and-slope model 

From the graphical display obtained in the previous section, it seems as if the HDRS 
scores follow an approximately linear trend over time, decreasing over the course of 
the study. It is also apparent, however, that patients not only start out at different 
levels but also have differences in the slopes of the HDRS against WEEK lines. In 
this section, we explore a model that allows patients not only to have unique 
intercepts, but also unique slopes across time. In other words, we allow both 
intercept and WEEK (slope) to vary randomly over patients. The image below 
demonstrates the meaning of the random slope and random intercept in a 
hypothetical 2-level model.  

 

Figure XXX.8: Score trends for individual patients 

1.2.2.1 The model 

The random intercept-and-slope model for the response variable HDRS may be 
expressed as 

 

    0 1 0 1HDRS WEEK WEEKij i i ijij ij
v v         

 

We can rewrite the model in the following way.  

Trend of patient 1 

Average trend of all patients 

Trend of patient 2 
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Level-1 model:  

 0 1HDRS WEEKij i i ijij
b b e     

Level-2 model:  

0 0 0

1 1 1

i i

i i

b v

b v




 

   
where  

 
 

2

( )

0,

,

i i

i v

N

N

 



I

v 0




 

 

0  denotes the average expected depression rating scale value, 1  denotes the 

coefficient of the predictor variable WEEK (slope) in the fixed part of the model, 1iv  

denotes the variation in the slopes over patients, and 0iv  and ije  denote the variation 

in the average expected HDRS value over patients and between patients respectively. 
Furthermore, i = 1,2,…,66 refers to the 66 patients; j = 1, 2, …, in  refers to the thj  

observation for patient i. The maximum value for in  is 6. 

1.2.2.2 Setting up the analysis 

Start by opening the reisby.ss3 file as a SuperMix spreadsheet. Next, select the New 
Model Setup option on the File menu as shown below to load the Model Setup 
window.  
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Starting with the Configuration screen, enter the (optional) title in the Title 1 and 
Title 2 text boxes respectively. The continuous outcome variable HDRS is selected 
from the Dependent Variable drop-down list box. The variable Patient, which defines 
the levels of the hierarchy, is selected as the Level-2 ID from the Level-2 IDs drop-
down list box to produce the following Configuration screen.  
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Click the Variables tab to proceed to the Variables screen of the Model Setup 
window. The variable Week is specified as the covariate of the fixed part of the 
model by checking the E check box for WEEK in the Available grid. Mark the 2 
check box for Week in the Available grid to specify the random slope at level 2 of the 
model. After completion, the Variables screen should look as shown below. 

  

 
 

Before the analysis can be run, save the model specifications to reisby1.mum. Run 
the model to produce the output file reisby1.out.  

1.2.2.3 Discussion of results 

Descriptive statistics 

The section of the output file shown below contains the descriptive statistics for all 
variables in the current model specification. If all patients' data were complete, the 
average for the time variable WEEK would have been exactly 2.5; the value of 2.48 
indicates that the number of patients with information at each time point fluctuates 
somewhat. 
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1.2.2.4 Interpreting the results 

The summary of the hierarchical structure of the data shows how the 375 
measurements are nested within the 66 patients. It also indicates that the number of 
repeated measurements per patient varies from 4 to 6 observations. The convergence 
is attained in 5 iterations. The output file contains the final estimates of the fixed 
and random coefficients included in the model, along with some goodness of fit 
measures as shown below.  
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Fixed effects results 

The results show a highly significant coefficient (p < 0.00001) for the time effect, as 
represented by the variable WEEK. At the beginning of the study, when WEEK = 0, 
the average expected HDRS score is 23.57695. For each subsequent week, a 
decrease of 2.37707 in average HDRS score is expected. At the end of the study 
period, the average expected HDRS score is 23.57695 – 5(2.37707) = 11.6916. 

Random effects results 

With the exception of the WEEK-intcept covariance, all variance components are 
highly significant, as shown in the p-value column. From the output above we have 


0var( )iv  = 12.62930,  1var( )iv  = 2.07899,  0 1cov( , )i iv v  = -1.42093, and var( )ije  = 

12.21663. Typically, one would expect most of the variation in HDRS scores at the 
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measurement level, and thus would expect var( )ije  to be larger than any of the other 

variances/covariances. With these data, however, there is more variation in the 
random intercepts over patients than in the measurements nested within patients. 
Due to this, it may be of interest to take a closer look at the variation in HDRS scores 
at the two levels of the hierarchy. 

Fit statistics and ICC 

In the case of a model with only a random intercept, there are two variances of 
interest: the variation in the random intercept over the patients (the level-2 units), 
and the residual variation at level 1, over the measurements. By calculating the total 
variation in the HDRS score explained by such a model, obtained as 
 

0var( ) var( )ij ie v , we can obtain an estimate of the intracluster correlation 

coefficient. 

 

The intracluster coefficient is defined as 

 

 


 
0

0

var( )

var( ) var( )
i

ij i

v
ICC

e v



 

 

and would, for a random intercept model for this data, represent the proportion of 
variation in HDRS scores between patients. The term intracluster correlation 
coefficient applies to random intercept models only; in more complicated models 
the focus is on explanation of variation in various coefficients. 

 

In the current model, the situation is somewhat more complicated due to the 
inclusion of both random intercept and random slope. This implies a possible 
correlation between the level-2 random effects. When calculating an estimate of the 
total variation, the covariance(s) between random effects have to be taken into 
account in any attempt to estimate the proportion of variation in outcome at any 
level or for any random coefficient. In addition, the inclusion of a covariate such as 
ENDOG can affect the variance estimates.  
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The total variation in HDRS scores over patients is defined as 

 

  2
0 1 0 1Var(level 2) var( ) var( )(WEEK) 2 cov( , ) (WEEK)i i ij i i ijv v v v    

 

The total variation is a function of the value assumed by the predictor WEEK, which 
has a random slope. As such, the total variation at the beginning of the study is 

 

 
 2

0 1 0 1

0

Var(level 2) var( ) var( )(0) 2 cov( , ) (0)

var( )
i i i i

i

v v v v

v

  


 

 

while at the end of the study we have 

 

 
 2

0 1 0 1

0 1 0 1

Var(level 2) var( ) var( )(5) 2 cov( , ) (5)

var( ) 25var( ) 10cov( , )
i i i i

i i i i

v v v v

v v v v

  

  
 

 

An estimate of the total variation at this level can be obtained by using the estimates 

of the variances and covariance obtained under this model. By substituting  0var( )iv , 


1var( )iv , and  0 1cov( , )i iv v  into the equations above, we obtain the estimated 

variation in HDRS scores over patients at different points during the study period. 

 

At the beginning of the study, the estimated total variation in HDRS scores over 

patients is simply the estimated variation in the random intercept, i.e.,  0var( )iv  = 

12.62930. At the end of the study, the total variation at level-2 is estimated as 

 

   
0 1 0 1Var(level 2) var( ) 25var( ) 10cov( , )

12.62930 25(2.07899) 10( 1.42093)

50.39475.

i i i iv v v v  
   

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At the beginning of the study we obtain  

 

 



 
var(level 2) 12.62930

12.62930 12.21663var(level 2) var(level1)

0.5083






 

 

and thus conclude that 50.8% of the variation in HDRS scores at this time is over 
patients. At the end of the study, we find that  

 



 
var(level 2) 50.39475

50.39475 12.21663var(level 2) var(level1)

0.8049,






 

 

so that only 20% of the variation in HDRS scores are estimated to be at the 
measurement level, with 80% at the patient level. As mentioned before, the total 
variation in HDRS scores is a function of the time of measurement, as represented by 
the variable WEEK. The very different estimates of variation at a patient level show 
how the introduction of an important predictor, in this case at the measurement 
level, can have an impact on variance estimates at a different level of the hierarchy. 
By the end of the study period, the residual variation over measurements has been 
dramatically reduced, this being explained to a large extent by the inclusion of the 
time effect. Most of the remaining unexplained variation is at the patient level.  

 

As a result of this finding and in the light of our original research question, whether 
the initial depression classification of a patient is also related to the HDRS scores 
over the time in which medication is administered, the model will be extended to 
include the covariate ENDOG. This dichotomous variable assumes a value of 1 when 
endogenous depression was diagnosed, and 0 if not. In addition, we will provide for 
a possible interaction between depression classification and measurement occasion 
by including the interaction term WxENDOG in the model. While WxENDOG can be 
viewed as a cross-level interaction, as WEEK is a measurement-level variable and 
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ENDOG a patient-level variable, the inclusion of the patient-level variable ENDOG 
may enable us to explain more of the remaining variation in the random intercepts 
and slopes at the patient level. 

1.2.3 A 2-level random intercept-and-slope model with centered predictor 

In the previous example, the time variable WEEK is coded from 0 to 5 and indicates 
the number of weekly follow-ups. The estimated average intercept of 23.577 
obtained for this model represented the expected average HDRS score at the 
beginning of the study, i.e. WEEK = 0. An alternative formulation of the model that 
can be considered is one in which the estimated average intercept represents the 
expected average HDRS score midway through the study period. This linear 
transformation of the predictor variable WEEK, in which the grand mean of the 
variable is subtracted from each observed WEEK value, is referred to as grand mean 
centering. While the model based on the "raw" data and the model utilizing grand 
mean centered variables can be shown to be mathematically equivalent, the 
coefficients in these models have very different meanings.  

1.2.3.1 Preparing the data 

Recall that the descriptive statistics in the previous model indicated a mean value 
over all level-1 observations of WEEK equal to 2.48. This is the true observed mean, 
compared to the value of 2.5 that would have been obtained if all patients had 
complete data over the course of the study. Here, we opt to use the value of 2.5 to 
center the WEEK variable.  

 

To grand mean center the predictor WEEK, proceed as follows. Open the reisby.ss3 
in the SuperMix spreadsheet, then highlight the column WEEK. Select the Insert 
Column option on the Edit menu as shown below to insert a blank column named D 
after WEEK.  
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Keep the column D highlighted, type the formula (C1)-2.5 in the string field of the 
top-left corner and click on the Apply button to produce the following screen.  

 

 
 

Rename the newly created variable to WEEKC by first highlighting the column, then 
selecting the Column Properties option on the Edit menu as shown below. 
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Input the desired variable name, e.g. WEEKC, in the Header string field as shown 
below and click on the OK button. By default, all variables are assumed to be 
continuous. 

 

 
 

Save the changes to reisby.ss3 by selecting the Save option on the File menu. 

1.2.3.2 The model 

The revised random intercept-and-slope model for the response variable HDRS may 
be expressed as 

 

    0 1 0 1HDRS WEEKC WEEKCij i i ijij ij
v v         
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or, alternatively, as 

 

    0 1 0 1HDRS WEEK WEEK WEEK WEEKij i i ijij ij
v v                 

 

where WEEK 2.5.  

1.2.3.3 Setting up the analysis 

Open the previous model setup for reisby1.mum. Save the file as reisby2.mum by 
using the Save As option on the File menu. Change the title on the Configuration tab 
if desired.  

 

Click on the Variables tab and select WEEKC both as Explanatory Variable and L-2 
Random Effects instead of WEEK as shown below.  
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Save the changes to the file reisby2.mum. Select the Run option on the Analysis 
menu to produce the output file reisby2.out. Use the Analysis, View Output option to 
open the output file. 

1.2.3.4 Discussion of results 

The output file contains the final estimates of the fixed and random coefficients 
included in the model, along with some goodness of fit measures as given below. 
Note that the use of grand mean centering of the time variable has no effect on the 
fit statistics.  
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1.2.3.5 Interpreting the results 

Comparison of models  

Table XXX.3 contains the estimates and standard errors of the above two analyses. 
The coefficient for WEEKC is the same as for the uncentered variable WEEK. 
However, the variance of the random intercept (

0

2
v ) and the covariance term 

0 1v v  

have changed. The covariance between the intercept and the WEEKC slope is now 
significant.  

 

TABLE XXX.3: Estimates and standard errors for two models 

 
Coefficient Level-2 model 

  WEEK = 0 ~ 5 WEEKC = -2.5 ~ 2.5 

0  23.57695 17.63428 

  (0.54555) (0.56031) 

 1  -2.37707 -2.37707 

  (0.20865) (0.20865) 

 
0

2
v  12.6293 18.51833 

  (3.46653) (3.61203) 

 
0 1v v  -1.42093 3.77654 

  (1.02595) (1.05839) 

 
1

2
v  2.07899 2.07899 

  (0.50417) (0.50416) 

 2
e  12.21663 12.21663 

  (1.10697) (1.10697) 

Deviance 2219.0375 2219.0375 

 AIC  2231.0375 2231.0375 

 SBC 2244.1754 2244.1754 
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 Number of free parameters  6 6 

 

As shown above, the estimates of the slope and its variance are the same. This is 
because the scale of WEEK was not changed; only its location changed. The 
estimated intercept decreased from 23.58 to 17.63, which corresponds to the average 
HDRS score at week 2.5 instead of week 0. Similarly, the 

0

2
v  of intercept increased 

to 18.52, which shows the increase of the individual variance at week 2.5. The 
change of 

0 1v v  is interesting: not only the value changed, but also the sign. The 

covariance of the first analysis tells us that the higher the variance of intercept, the 
lower the variance of slope. Or say, at week 1, the HDRS score decreases at a faster 
rate for those patients who started with higher HDRS. However, at week 2.5, the 
patients with higher HDRS tend to improve less. When looking at the three HDRS 
versus WEEK plots for patient 604, 302 and 361 below, we can see why this could 
happen. The graphs show the change of 

0 1v v  from week 0 to week 2.5. 

 

   
Figure XXX.9: Changes in covariance over time 

1.2.4 A random intercept-and-slope with a covariate and an interaction 
term 

The type of depression a patient was diagnosed with was recorded as part of the 
study and information on this patient characteristic is represented by the variable 
ENDOG, which assumes a value of 1 for patients with endogeneous depression and 0 
otherwise. Including this variable in the model allows us to explore the potential 
relationship between a patient's HDRS score and the type of depression the patient 
was diagnosed with. Moreover, it is possible that the trend in HDRS scores over the 
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study period may differ for the two ENDOG groups. Including an interaction term 
between the time of measurement and the type of depression in the model will allow 
us to evaluate this potential relationship as well. 

1.2.4.1 The model 

We now include ENDOG and WxENDOG in the level-1 model. ENDOG is a dummy 
variable representing the type of depression a patient was diagnosed with, and 
WxENDOG represents the interaction between WEEK and ENDOG. The model shows 
changes at both levels: at level 2, the covariate ENDOG is now included, while at 
level 1 the interaction between WEEK and ENDOG, which can potentially change 
from week to week, is added. The revised model for the response variable HDRS 
may be expressed as  

 

Level-1 model:  

 

   0 1 2HDRS WEEK WxENDOGij i i i ijij ij
b b b e       

 

Level-2 model:  

 0 0 3 0

1 1 1

2 2

ENDOGi ii

i i

i

b v

b v

b

 




   

 


 

 

or, in mixed model formulation, as 

 

     
 

0 1 2 3

0 1

HDRS WEEK WxENDOG ENDOG

WEEK

ij ij ij i

i i ijij
v v e

         

   
 

 

where 0  denotes the average HDRS level at week 0 for the non-endogenous 

depression patients (ENDOG=0), 1  refers to the weekly improvement for the non-



 
 
 

59 
 

endogenous group, 2  indicates the expected change in HDRS score for a unit 

change in the value of the interaction term WxENDOG, and 3  refers to the average 

expected change in HDRS level for endogenous patients. 0iv  is the individual 

deviation from the average intercept. 1iv  denotes the average deviation from the 

slope, or say, average improvement of the HDRS.  

 

We can also write the model in terms of our original variables (WEEK and ENDOG) 
as: 

 

Level-1 model:  

 

   0 1 2HDRS WEEK WxENDOGij i i i ijij ij
b b b e       

 

Level-2 model:  

 
 

0 0 2 0

1 1 4 1

ENDOG

ENDOG

i ii

i ii

b v

b v

 

 

   

   
 

1.2.4.2 Setting up the analysis 

To create the model specifications for this model, we start by opening reisby.ss3 in 
a SuperMix spreadsheet window. Then we use the Open Existing Model Setup option 
on the File menu to load the Model Setup window for reisby1.mum. Save the file as 
reisby3.mum by using the Save As option on the File menu. Change the string in the 
Title 1 text box on the Configuration screen to reflect the new model, thereby 
producing the following dialog box.  
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Next, click on the Variables tab to proceed to the Variables screen of the Model 
Setup window. 
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The two covariates are specified by checking the E check boxes for ENDOG and 
WxENDOG respectively in the Available grid respectively to produce the following 
Variables tab.  

 

Save the changes to the file reisby3.mum. To fit the revised model to the data, select 
the Run option on the Analysis menu to produce the output file reisby3.out.  

1.2.4.3 Interpreting the results 

Fixed effects results 

A portion of the output file reisby3.out is shown below. The interaction WxENDOG 
between the time variable WEEK and the depression classification variable ENDOG, 
is not significant. Given this, we can take a closer look at the estimated coefficients 
for the main effects WEEK and ENDOG respectively. Note, however, that the p-value 
for the ENDOG coefficient is larger than 0.05, and thus can only be considered 
significant at a 10% level of significance. The effect of time, on the other hand, is 
found to be highly significant. While the average HDRS score is predicted to 
decrease by -2.37 score scale units each week, patients classified as having 
endogenous depression (i.e., ENDOG = 1) are predicted to have a HDRS score of 2 
units higher at all occasions.  
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To obtain the predicted average HDRS scores, the estimates obtained from the output 
are used: 

 

 
    

0 1 2 3(WEEK) (ENDOG) (WxENDOG)

22.47626 2.36569(WEEK) 1.98802(ENDOG) 0.02706(WxENDOG)

y       

   
  

 

Model comparison 

A question that arises from inspection of the results obtained thus far is whether the 
interaction term contributes overall to the explanation of the variation in the HDRS 
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scores. To test this, we can fit a model without the interaction term and use the 
deviance reported in the output to compare results for the model with interaction 
and the model without this term. The relevant output from an analysis without the 
interaction term is shown below. We note that the deviance obtained for the simpler 
model is almost identical to that of the model considered in this section. Based on 
this, we conclude that a model without the interaction WxENDOG would fit the data 
as well as the one with the interaction term included. 

 

 
  

In addition, we can test the hypothesis that the model with covariate (ENDOG) fits 
the data better than the random intercept and slope model considered previously. To 
test this hypothesis, we calculate the difference between the -2 log likelihood value 
obtained for the previous model and the -2 log likelihood value for the current 
model. It can be shown that this difference of 2219.04 – 2214.93 = 4.11 has a 2  
distribution with associated degrees of freedom equal to the difference in the 
number of parameters estimated in the two examples, i.e., 8 – 7 = 1 degrees of 
freedom. Since the p-value for this test statistic is less than 0.05, it is concluded that 
the random intercept-and-slope model with ENDOG as a covariate provides a better 
description of the data than the original random intercept-and-slope model. This 
finding is supported by the fact that the p-value for ENDOG when the interaction 
effect between WEEK and ENDOG is excluded equals 0.04. 
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1.2.5 A random intercept-and-slope quadratic model 

1.2.5.1 The model 

In this section we include an additional predictor and a random term to examine a 
possible quadratic response trend in HDRS scores over time. Keeping the level-2 
model the same as before, the corresponding model for the response variable HDRS 
may be expressed as  

 

Level-1 model: 

 

   2
0 1 2HDRS WEEK WEEKij i i i ijij ij

b b b e       

 

Level-2 model:  

0 0 0

1 1 1

2 2 2

i i

i i

i i

b v

b v

b v





 

 
 

 

1.2.5.2 Preparing the data 

Create a new blank variable named WEEKSQ as shown in section XXXX. Highlight 
the column WEEKSQ, type the formula SQUARE(C1) where C = WEEK in the string 
field and click on the Apply button to produce the following screen. Save the change 
to reisby.ss3. 
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1.2.5.3 Setting up the analysis 

Again, we can modify the model setup file of reisby1.mum by first opening it, then 
saving the file as reisby4.mum. Change the title on the Configuration tab and request 
Bayes estimates by selecting the means & (co)variances option from the Write Bayes 
Estimates drop-down list. 
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Next, click on the Variables tab to proceed to the Variables screen of the Model 
Setup window. The two covariates are specified by checking the E and 2 check 
boxes for WEEKSQ in the Available grid to produce the following Variables screen.  

 

 
 

Save the changes to the file reisby4.mum and run the model.  

1.2.5.4 Interpreting the results 

A portion of the output file reisby4.out is shown below.  

Fixed effects results 

The level-1 estimate of the WEEKSQ coefficient is 0.05, which turns out not to be 
significant (p = 0.56). On the other hand, the WEEKSQ random effect is significant 
at a 5% level (p = 0.04). Comparing the present results with those reported in 
reisby1.out, we see that the deviance difference of 2219.04 – 2207.65 = 11.19 with 
10 – 7 = 3 degrees of freedom, indicating an improved overall model fit at a 5% 
significance level. These results imply that, although the mean trend of HDRS scores 
over time is linear, some of the individuals' trajectories are quadratic. 
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1.2.5.5 Residuals 

Level 2 Bayes results 

Up to this point, we have considered results averaged over all patients. We now turn 
our attention to the residual file reisby4.ba2, which offers the opportunity to take a 
closer look at the results by individual patient. After running the above model, select 
the Analysis, View L-2 Bayes Results option to open the image below. The contents 
of this file are displayed for the first 5 patients. Three lines of information are given 
for each patient, containing, in order of appearance, 

 

o the number of the patient in the data set,  

o the number of the empirical Bayes coefficient,  
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o the empirical Bayes estimate,  

o the estimated variance of the Bayes coefficient, and  

o the name of the associated coefficient as used in the model.  

 

 
 

To obtain patient-specific predicted HDRS scores, the empirical Bayes estimates for 
each patient have to be taken into account, as these estimates indicate the extent to 
which the random intercept or slope for that patient deviates from the intercept and 
slope over all patients. Patient-specific predicted HDRS scores are calculated as 

 

 2

2
0 1 2

ˆ| 23.76025-2.63258 WEEK 0.05148 WEEK

WEEK WEEK

ij ij ij

i i ij i ij

y

v v v

    

    
 

 

For the first patient shown in the residual file above, we have 0iv  = 1.4054, 1iv  = 

2.6506  and 2iv  = 0.099315. From this information, we can already tell that the 
intercept for the patient is higher than average, but that the WEEK slope for this 
patient is lower than average. The positive value of the quadratic term indicates that 
the decreasing rate slows down more quickly than average with an increase in time. 
The predicted HDRS score for this patient (PATIENT = 101) is found to be 
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 2

2

ˆ| 23.76025-2.63258 WEEK 0.05148 WEEK

1.4054-2.6506 WEEK 0.099315 WEEK

ij ij ij

ij ij

y     

   
. 

 

Substituting the WEEK with values 0, 1, …, 5, we get the predicted HDRS scores for 
Patient 101, and similarly, for all the other patients. Table XXX.4 and the graphical 
display below give the predicted HDRS for the first 5 patients. 

 

Table XXX.4: Predicted HDRS values for selected patients 
 

 Patient 101 Patient 103 Patient 104 Patient 105 Patient 106 
Population 

Avg. 

Week 0 25.166 27.507 25.998 21.011 23.643 23.760 

Week 1 20.033 24.192 22.727 18.224 22.757 21.179 

Week 2 15.202 21.117 19.102 15.765 21.587 18.701 

Week 3 10.673 18.282 15.124 13.636 20.133 16.326 

Week 4 6.446 15.686 10.792 11.836 18.396 14.054 

Week 5 2.520 13.330 6.106 10.365 16.375 11.884 
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Figure XXX.10: Predicted HDRS for selected patients 

 

We find that Patient 101 had a higher initial HDRS score, but over time obtained a 
lower than average score. For Patient 103, a higher than average predicted HDRS 
score is obtained at each time point. In contrast, Patient 105 scored lower at each 
time point. The quadratic term doesn’t affect much of the population average; 
however the effect is obvious for Patients 105 and 106. 

Model-based graphs 

Residual plot 

 

Level-1 residuals can also be obtained, either for a typical or specific patient, by 
using the empirical Bayes estimates. The residuals for a typical patient are obtained 
as  
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

2

Patient residual Observed HDRS score |

Observed HDRS score 23.76025-2.63258 WEEK 0.05148 WEEKij ij

y  

      
 

 

The residuals for a specific patient use the additional information given by the 
empirical Bayes residuals and have the form 

 



2 2
0 1 2

Patient-specific residual Observed HDRS score |

Observed HDRS score

23.76025-2.63258 WEEK 0.05148 WEEK WEEK WEEKij ij i i ij i ij

y

v v v

 
 

         
 

Select the Residuals option on the File, Model-based Graphs menu to activate the 
Plot of Residuals dialog box. Check the Mark check box for WEEK as shown below, 
then click on the Plot button.  

 

 
 

The graph obtained, as shown below, shows that, in general, the range of the level-1 
residuals is 5 5( ; ) .  
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Figure XXX.11: Plot of level-1 residuals vs. predicted values 

 

Inspection of these residuals can be useful in examining the distributional 
assumptions for the level-1 data, in this case at the measurement level. For the 
current example, residuals for a typical patient have a mean of 0.000 with standard 
error of 2.66. Click on the middle of the graph to open an additional window that 
shows the detailed residual data for each observation. 
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We note that the estimate for Patient 101 at the beginning of the study was 25.166, 
and 2.520 at the end of the study. On both occasions, the residuals associated with 
these estimates were positive, indicating that the estimates are above estimated 
average.  

1.2.6 A 2-level random intercept-and-slope model with autocorrelated 
errors 

In the mixed models discussed so far, it was assumed that the level-1 errors are 
conditionally independent from each other. However, the errors could be correlated 
over time. Different types of correlated error structures are available in SuperMix: the 
first-order stationary autoregressive process, stationary AR(1), the first-order non-
stationary autoregressive process, non-stationary AR(1), the first-order stationary 
moving average process, MA(1), the first-order stationary autoregressive moving 
average process, ARMA(1), and a general Toeplitz autocorrelation structure.  

 

The stationary AR(1) and ARMA(1) use the stationary assumption, that is that the 
variance of errors is constant over time and that the covariance of errors from 
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differing times depends only on the time interval between these time points and not 
on the starting time point. The assumption of stationarity is relaxed in the other two 
types of models. In SuperMix, the maximum marginal likelihood (MML) solution at 
convergence is obtained by first using the EM algorithm and then Fisher scoring 
iterations.  

1.2.6.1 The non-stationary AR(1) model 

The model here is essentially the same as the one we had in section XXX, apart 
from the autocorrelated error term.  

 

Level-1 model: 

  

0 1 2HDRS WEEK WxENDOG ,ij i i ij i ij ijb b b e       

where 

 , 1ij i j ije e    

with   denoting the AR coefficient. 

 

Level-2 model: 

0 0 3 0

1 1 1

2 2

ENDOGi i i

i i

i

b v

b v

b

 



   
 



 

 

We can rewrite the model as follows: 

 

 
 

0 1 2 3

0 1

0 1 1 2 3

0

HDRS WEEK ENDOG WEEK ENDOG

WEEK

WEEK ENDOG WEEK ENDOG

ij ij ij ij

i i ij ij

i ij ij ij

ij i

u u e

u

e u

   

   

       

   

        

 
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The difference between the present and previous models lies in the assumption 
concerning the error term. Previously, we assumed that 1 2( , ,..., ) '

ii i i ine e ee  

 2, iN 0 I , where iI  is an identity matrix of order i in n .  Now we assume that 

the errors are autocorrelated, and that   2,i iN e 0 Ù , where iÙ  is the 

autocorrelation matrix. 

The analysis – step 1: starting values from a non-AR model 

Two types of iteration algorithms, EM and Fisher scoring, are used for fitting an 
autoregressive model. The EM solution proceeds by assigning starting values for the 
structural and population parameters. The Fisher scoring procedure utilizes the first 
derivatives and expected values of the second derivatives to obtain improved 
parameter estimates. 

 

Although the Fisher scoring solution is a significant improvement in terms of speed 
of convergence over the EM solution, it can fail in the estimation of the covariance 
matrix of the random effects when these terms become very small. The most reliable 
way to minimize the chance of encountering convergence problems is first obtaining 
the starting values by running the model without autocorrelated errors, then 
substituting the starting values obtained prior to fitting the AR model.  

 

Recall that in Section XXXX we fitted the model 

 

Level-1 model:  

 

0 1 2HDRS WEEK WxENDOGij i i ij i ij ijb b b e       

 

Level-2 model:  

0 0 3 0

1 1 1

2 2

ENDOGi i i

i i

i

b v

b v

b

 



   

 

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The estimates obtained for that model are repeated below. 

 

 
 

The level-2 estimated variance of intercept and WEEK are 11.64121 and 2.07707 
respectively. The estimated level-2 covariance is -1.40161. The estimated level-1 
variance is 12.21847. These numbers will be used as the starting values in the non-
stationary AR model to be fitted next. 
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The analysis – step 2: non-stationary AR model 

We modify the model setup file, reisby3.mum, by first saving the file as 
reisby_ar2.mum. Change the title on the Configuration screen. Keep the settings of 
the Variables tab the same as before.  

 

Click on the Starting Values tab. Select the user-defined option from the Starting 
Values drop down list to activate the grid fields for the starting values. Input the 
starting values we obtained from reisby.out to generate the following screen. 

 

 
 

Click on the Advanced tab to proceed to the Advanced screen. First, select the 
estimate all option from the Autocorrelation drop down list; then select Non-
stationary AR1 as the Error Form and specify WEEK as the ‘Time’ Variable. Input 0.1 
in the Autocorrelation Starting Values grid field to get the Advanced screen as shown 
below.  
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Save the changes to reisby_ar2.mum and run the model to produce the output file 
reisby_ar2.out.  

1.2.6.2 Interpreting the output 

The output for the AR model first shows the syntax information of the model setup. 
The number of observations, hierarchical structure of the 2-level model and 
descriptive statistics follow next.  

The starting values 

The starting values could either be user-defined or program generated. In our case 
the user-defined starting values are listed below. 
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The Starting values section in the output file corresponds with the starting values 
we specified in the Starting Values and Advanced screens. The mean row refers to 
the starting values for the fixed regressors, which are intercept and WEEK in this 
example. The covariates row contains the starting values for ENDOG and 
WxENDOG. The elements of the var. terms row are the starting values for the level-
2 variance/covariance matrix. The residual value is the starting error variance. The 
auto term(s) is the autocorrelation starting value(s).  

The maximum marginal likelihood (MML) estimates  

The starting values section is followed by the Final Results. The maximum 
marginal likelihood (MML) solution at convergence is obtained by first using EM 
algorithm and then Fisher scoring iterations. The AIC, SBC and -2 log likelihood 
(deviance) are given right below the iteration information. 
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As shown above, the convergence is obtained after 10 EM and 10 Fisher iterations. 
The log likelihood value can be used to perform likelihood ratio tests.  

 

For each model parameter, maximum marginal likelihood estimates, standard errors, 
z-values, and p-values are provided. These p-values are two-tailed, except for the 
variance parameters where one-tailed p-values are given. 

 

 
 

Considering the estimated fixed effects, the initial level of severity for non-
endogenous patients is approximately 22.5 on the HDRS, while the endogenous 
patients start about 1.9 units higher. The difference in initial severity is almost 
significant (p < 0.0790). The reason that the intercept and endogenous effect reflect 
HDRS levels at week 0 is due to the coding of WEEK that was used, namely, 0 to 6 . 
Using other codings of WEEK would change the meaning of these regression 
coefficients. 

 

Both groups exhibit an overall weekly rate of improvement of roughly 2.3 units 
which is highly significant. In terms of the random-effect variance and covariance 
terms, there is a significant rate of improvement (p < 0.00343). The variation in 
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patients’ initial severity is marginally significant at 0.066. However, the overall 
covariation between those two terms are significant at a 10% level (p > 0.90864). 

Correlation of the MML estimates  

Finally, correlation matrices are also provided for the estimates of all model 
parameters. It is important to realize that these correlation matrices are not 
correlations of the variables themselves, but correlations of the estimated model 
parameters. These matrices may be helpful in determining the degree to which 
collinearity is present in terms of the model parameters. 

 

 
 

It is interesting to note that, when the correlations are rounded to two decimal 
places, equalities exist between the correlations: 

 

 

(INTCEPT,ENDOG) (WEEK, WxENDOG) 0.74
(INTCEPT, WEEK) (ENDOG, WxENDOG) 0.45

(ENDOG, WEEK) (INTCEPT, WxENDOG) 0.33

r r
r r

r r

  
  
   
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From the fixed effect results we see that the WxENDOG effect was not significant 
( 0.976p  ). It is reasonable to assume that, with the interaction term omitted from 
the model, the correlations between the intercept, ENDOG and WEEK coefficients 
will be close to those reported above. 

Level-2 Bayes results 

The residual file reisby_ar2.ba2 offers the opportunity to take a closer look at the 
results by individual patient. Select the Analysis, View L-2 Bayes Results option to 
open the Bayes results as shown below. The contents of this file are displayed for 
the first 7 patients. Two lines of information are given for each patient, containing, 
in order of appearance, 

o the number of the patient in the data set,  

o the number of the empirical Bayes coefficient,  

o the empirical Bayes estimate,  

o the estimated variance of the Bayes coefficient, and  

o the name of the associated coefficient as used in the model.  

 

 
 

The user can obtain patient-specific predicted HDRS scores using the empirical 
Bayes estimates for each patient by using the method discussed earlier in section 
XXX. 
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Model comparison 

In Table XXX.5, the estimates of the regular model without an autoregressive term 
and the non-stationary AR(1) are summarized. Note that the AIC and BIC values 
obtained from the AR(1)  model were multiplied by – 2.0 in order to facilitate 
comparison over the models. 

 

TABLE XXX.5: Comparison of models with and without AR(1) term 

 

 no AR term 
Non-stationary 

AR(1) 

intcept 22.47626 22.47646 

 (0.79435) (0.78704) 

WEEK -2.36569 -2.33888 

 (0.31181) (0.30299) 

ENDOG 1.98802 1.85677 

 (1.06905) (1.05917) 

WxENDOG -0.02706 -0.01205 

 (0.41947) (0.40784) 

Log Likelihood -1107.4646 -1103.72 

Akaike's Information Criterion 2214.9292 2217.44 

Schwarz's Bayesian Criterion 2230.9292 2237.076 

-2 Log Likelihood 2248.4465 2207.441 

Number of free parameters 8 9 

 

We notice that the estimates of both models are close to each other. The estimated 
variances of the non-stationary AR(1) model are smaller for all the parameters. The 
deviance is  2248.4465 - 2207.441 =  41.0055 with 1 degree of freedom, which is 
highly significant. Thus, we conclude that in this example, the non-stationary AR(1) 
model fits the data better.  
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1.3 Models based on the TVSFP data 

1.3.1 The data 

The data set used here is from the Television School and Family Smoking 
Prevention and Cessation Project (TVSFP)(Flay et. al., 1988). The study was 
designed to test independent and combined effects of a school-based social-
resistance curriculum and a television-based program in terms of tobacco use and 
cessation. The data from the study included a total of 1,600 students from 135 
classrooms drawn from 28 schools. Schools were randomized to one of four study 
conditions:  

 

o a social-resistance classroom curriculum 

o a media (television) intervention 

o a social-resistance classroom curriculum combined with a mass-media 
intervention, and 

o a no-treatment control group 

 

A tobacco and health knowledge scale (THKS) was used in classifying subjects as 
knowledgeable or not. In its original form, the student's score was defined as the 
number of correct answers to seven items on tobacco and health knowledge. 

 

While the structure of this study indicates a three-level hierarchical structure, the 
present application uses these data to fit a two-level model, with students nested 
within either classes or schools, in order to present an introduction to the analysis of 
ordinal outcomes. A 3-level model is presented in Section XXX. 

 

Data for the first 10 students on most of the variables used in this section are shown 
below in the form of an SuperMix spreadsheet file, named TVSFP.ss3. 
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The variables of interest are: 

o SCHOOL indicates the school a student is from (28 schools in total). 

o CLASS identifies the classroom (135 classrooms in total). 

o POSTTHKS represents the post-intervention tobacco and health 
knowledge scale. It is treated as a continuous variable in the examples in 
this chapter. See Chapters XXX & XXX for examples where POSTTHKS 
is treated as a binary or ordinal outcome. 

o PRETHKS indicates the pre-intervention THKS score. 

o CC is a binary variable indicating whether a social-resistance classroom 
curriculum was introduced, where 0 indicates “no” and 1 “yes.” 

o TV is an indicator variable for the use of media (television) intervention, 
with a “1” indicating the use of media intervention, and “0” the absence 
thereof. 

o CCxTV was constructed by multiplying the variables TV and CC, and 
represents the CC by TV interaction. 

1.3.1.1 Exploring the data 

In this section, a univariate bar chart and a bivariate box-and-whisker plot are given. 
More information on other types of plots available are given in Chapter XXX. 
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Univariate graphs 

The pop-up menu below shows the data-based graphing options currently available 
in SuperMix. As a first step, we will take a closer look at the distribution of the total 
post-intervention scores (POSTTHKS), which is the potential dependent variable in 
this study. While scores such as these are not truly continuous variables, they are 
often treated as if they were. 

Bar chart 

To do so, select the Univariate option from the Data-based Graphs menu as shown 
below. 

 

 
 

The Univariate plot dialog box appears. Select the variable POSTTHKS and indicate 
that a Bar Chart is to be graphed. Click the Plot button to display the bar chart. 
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The bell-shaped bar chart below shows that the variable POSTTHKS is 
approximately normally distributed. Note that histograms are usually used for the 
depiction of the distribution of a continuous variable.  

 

 
Figure XXX.12: Bar chart of POSTTHKS scores 
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Bivariate graphs 

It is hoped that the social-resistance classroom curriculum (CC), the television 
intervention (TV) and the CC and TV interaction combination (CCxTV) would affect 
the tobacco and health knowledge (POSTTHKS). Before we start with the model, we 
would like to show a box-and-whisker plot of POSTTHKS for each category of CC.  

Box-and-whisker plots 

A box-and-whisker plot is useful for depicting the locality, spread and skewness of 
variables in a data set and may be used to examine the distributions of continuous 
variables, such as for the different values of discrete valued predictors. This option 
is accessed via the Data-based Graphs, Bivariate option on the File menu. 

 

To assign labels to the categories of CC, right-click on the CC column in the 
spreadsheet and select Column Properties. On the Column Properties dialog box, 
select the Nominal option and assign the appropriate labels. 

 

 
 

The Bivariate plot dialog box is completed as shown below: select the outcome 
variable POSTTHKS as the Y-variable of interest, and the predictor CC to be plotted 
on the X-axis. Check the Box and Whisker option, and click Plot.  
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Figure XXX.13: Box-and-whisker plots of POSTTHKS scores for different CC 
values 
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The bottom line of a box represents the first quartile ( 1q ), the top line the third 

quartile ( 3q ), and the in-between line the median (me). The arithmetic mean is 

represented by a diamond. Here, the mean of POSTTHKS is lower in the group 
without the social-resistance classroom curriculum (CC). The box-and-whisker plot 
indicates a positive relationship between CC and POSTTHKS. 

1.3.2 A 2-level random intercept model using classroom as level-2 ID 

1.3.2.1 The model 

The first model fitted to the data explores the cluster effects of each classroom on 
the outcome. The mixed model can be expressed as  

 

0 1 2 3 0POSTTHKS CC TV (CC TV )ij i i i i i ijv           , 

 

where 0iv  represents the classroom influence on POSTTHKS. To understand the 

model better, we can rewrite the model in the following way. The level-1 or within-
cluster model is shown below. 

 

Level-1 model: ( 1 )ij … n     

 

0POSTTHKSij i ijb   , 

2(0 )ij NID   

 

The level-1 model estimates POSTTHKS as a function of the intercept 0ib  and error 

term ij . Subscript i denotes the subscript for classroom, while subscript j refers to 

the student j. in  is used to denote the number of students in each classroom. 

Because we have different numbers of students in different classrooms, in  also 

varies. In this data set, 1 28in  .  
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The level-2, or between-cluster, model describes the intercept 0ib  as a function of 

cluster characteristics. 

 

Level-2 model: ( 1 )i … N    

 0 0 1 2 3 0CC TV (CC TV )i i i i i ib v          

 2
0 (0 )i vv NID   

 

As shown above, the intercept 0ib  is estimated as a function of the population 

average 0 , the covariates CCi , TVi , and CC TVi i , and the classroom 

difference 0iv . The coefficient 0iv  represents the amount that unit i deviates from 

the average 0 , after controlling for the effects of the covariates included. The 

level-2 residual 0iv  is assumed to follow 2(0 )vNID   for all the is. If 0 0iv   for all 

i , which implies 2 0v  , the model is the same as the ordinary regression model. 

1.3.2.2 Setting up the analysis 

Open the SuperMix spreadsheet TVSFP.ss3 used during the exploratory analysis 
discussed previously in this chapter. The next step is to describe the model to be 
fitted. We use the SuperMix interface to provide the model specifications. From the 
main menu bar, select the File, New Model Setup option.  

 

Select the continuous outcome variable POSTTHKS from the Dependent Variable 
drop-down list box. Select the classroom number CLASS from the Level-2 IDs drop-
down list box. Enter a title for the analysis in the Title text boxes. In this example, 
default settings for all other options associated with the Configuration screen are 
used.  
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Proceed to the Variables screen by clicking on that tab. The Variables screen is used 
to specify the fixed and random effects to be included in the model. Select the 
explanatory (fixed) variables using the E check boxes next to the variables names in 
the Available grid at the left of the screen. Note that, as the variables are selected, the 
selected variables are listed in the Explanatory Variables grid. After selecting all the 
explanatory variables, the screen shown below is obtained. The Include Intercept 
check box in the Explanatory Variables grid is checked by default, indicating that an 
intercept term will automatically be included in the fixed part of the model.  

 

Next, specify the random effects at level 2 the hierarchy. In this example, we want 
to fit a model with random intercepts at level 2. By default, the Include Intercept 
check box in the L-2 Random Effects grid is checked. If this box is left checked, and 
no additional random effects are indicated using the 2 column in the Available grid 
to the left, the model fitted will be the random-intercepts-only model we intend to 
use. No further changes on this screen are necessary. 
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Before running the analysis, the model specifications have to be saved. Select the 
File, Save As option, and provide a name (TVSFP1.mum) for the model specification 
file. Run the analysis by selecting the Run option from the Analysis menu. 

1.3.2.3 Discussion of results 

Program information and syntax 

Data summary 

In the numbers of observations section, a summary of the hierarchical structure is 
provided. 

 

As shown below, data from a total of 1600 students within 135 classrooms were 
included at levels 2 and 1 of the model. This corresponds to the study design 
described earlier. In addition, a summary of the number of students nested within 
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each classroom is provided. The classroom with N2 = 6, for example, had 26 
students (N1: 26). By contrast, classroom 26 had only 1 student. 

 

 

Descriptive statistics and starting values 

Next, the descriptive statistics for all variables are given.  
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The minimum value, maximum value, mean and standard deviation are given for all 
the variables included in the model. For example, the mean POSTTHKS is 2.6618 
with a standard deviation of 1.38293. 

Starting values – OLS estimates 

The starting values for the fixed regressor(s) are shown below. The log likelihood 
value and number of free parameters of the OLS regression are given in this part 
of the output. 
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After the number of free parameters, the starting values of variance/covariance 
components are reported as shown. 

 

 

Fixed effects estimates 

The number of iterations needed to obtain convergence is given after the starting 
values. The output describing the estimated fixed regressor(s) after convergence is 
shown next.  
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As shown above, the estimates for CC and TV are both positive. On average, a 
social-resistance classroom curriculum can improve the tobacco and health 
knowledge by 0.58910, and television intervention can increase the POSTTHKS 
score by 0.12018. However the estimate of CCxTV is negative, which implies that 
the students who had both CC and TV are expected to show a decrease of 0.24713 in 
their POSTTHKS score. The estimates associated with intercept and TV are highly 
significant, but estimates of the other two coefficients are not statistically 
significantly different from zero. 

 

The estimates for the fixed regressors and model fit statistics are given next. For 
more information on these statistics, see Section XXX. 
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Random effect estimates 

The estimates for the random part of the model are reported next. The variation in 
the average estimated intercept at level 2 is highly significant, which indicates that 
the classroom difference in intercepts does help to explain the variation in 
POSTTHKS scores. 

 

 
 

The covariance and correlation matrix of level-2 and level-1 random effects are 
given at the end of the output file. These values are the same as the estimates of 
variance/covariance components as shown above. 
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End of the output 

After successfully running a SuperMix model, the following message is shown at the 
end of the output file to indicate the CPU time and the type of the outcome variable. 
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1.3.2.4 Interpreting the results 

Estimated outcomes for different groups 

For a student who participated in neither social-resistance classroom curriculum nor 
television intervention (CC = 0; TV = 0), the expected POSTTHKS is equal to just the 
intercept 2.36105. For a student who participated in both programs (CC = 1; TV = 1; 
CCxTV = 1), the predicted POSTTHKS is calculated as follows: 

 

    
0 1 2 3POSTTHKS CC TV (CC TV )

2.34116 0.5891 0.12018-0.24713

2.80331

ij i i i i       

  


. 

Fit statistics and % variation explained 

An estimate of the percentage of variation in the outcome at classroom level is 
obtained as 

 
0.13361

100% 7.18%
0.13361 1.72651 

 


 

 

indicating that about 7.18% of the total variance lies between the 
clusters/classrooms and that 92.82% of the variance remains at the student level.  

1.3.3 2-level random intercept model by using school as level-2 ID 

The model in the previous section shows that only about 7% of the total variation in 
outcome is at the classroom level. The question that arises is whether clustering 
within schools may provide a better explanation of the way in which post-
intervention scores vary. In this section, the model is fitted using SCHOOL, rather 
than classroom, as the level-2 ID. 

1.3.3.1 The model 

The mathematical equation of the model to be fitted is exactly the same as for the 
previous model.  



 
 
 

101 
 

 

0 1 2 3 0POSTTHKS CC TV (CC TV ) ,ij i i i i i ijv            

 

The difference here is in the meaning of the subscript i. In the previous model, we 
used i to refer the classroom. However, the is here refer to the schools.  

1.3.3.2 Setting up the analysis 

To create the model specifications for this model, we start by opening TVSFP.ss3 in 
a SuperMix spreadsheet window. Then we use the Open Existing Model Setup option 
on the File menu to load the Model Setup window for TVSFP1.mum. Click on File, 
Save as to save the model setup in a new file, such as TVSFP2.mum. Next, change 
the string in the Title 1 text box on the Configuration screen, and select SCHOOL as 
the Level-2 ID as shown below. 
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Keep all the other settings unchanged. Save the changes to the file TVSFP2.mum and 
select the Run option on the Analysis menu to produce the output file TVSFP2.out.  

1.3.3.3 Discussion of results 

Data summary 

The number of observations section clearly shows that the data set contains 28 
schools and each school has between 18 and 137 students as shown below. 

 

  

Fixed effects estimates and descriptive statistics 

The estimates for the fixed estimates are shown below. They are close to the 
estimates in the previous example, but not exactly the same. For example, the 
estimate for CC increased by 0.06326 (0.65236 - 0.58910 = 0.06326), and the 
estimate for the effect of television intervention is about 0.07811 higher when using 
school as the level-2 ID (0.19829 - 0.12018 = 0.07811). However the estimate of the 
interaction of CC and TV is about 0.17 lower. 
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Both the deviance and Akaike information criterion (AIC) are slightly higher than 
the previous model. The SBC is smaller.  

 

  

Random effect estimates and covariance/correlation matrices 

The estimates for the random part of the model are reported next. 
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The variation in the average estimated intercept at level 2 is highly significant, 
which indicates that the difference in school intercepts also explains the variation of 
POSTTHKS scores. Similarly, we can calculate that about 3.84% of the total variance 
can be explained by the school difference: 

 

0.07131
100% 3.84%

0.07131 1.78756 
 


. 

1.3.4 A 3-level random intercept model using class and school as IDs 

The previous two models show that both school and classroom contribute to the 
explanation of the total variation of the POSTTHKS scores. We now construct a 
three-level model that uses both CLASS and SCHOOL as level-2 and level-3 IDs. 

1.3.4.1 The model 

The level-1 and level-2 models are the same as the previous two models, as shown 
below. 

 

Level-1 model ( 1 )ijk … n     

 

0POSTTHKSijk ij ijkb   , 
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2(0 )ijk NID   

 

Level-2 model ( 1 )ij … n    

 0 0 1 2 3 0CC TV (CC TV )ij i i ij i ij i ij ij ijb b b b b v       

 2
0 (2)(0 )ij vv NID   

 

Level-3 model ( 1 )i … N    

 

0 0 0

1 1

2 2

3 3

i i

i

i

i

b v

b

b

b






 






 

 2
0 (3)(0 )i vv NID   

 

In this mixed model the intercept 0ijb  is estimated by a level-2 equation. It indicates 

that classroom j’s initial value is not only determined by the population average 0ib , 

but also by the classroom difference 0ijv . The level-2-intercept 0ijb  is estimated by a 

level-3 equation which takes the school difference 0iv  into consideration, where i 

denotes the school ID.  

 

The above model can also be written in the following format. 

 

0 1 2 3 0 0POSTTHKS CC TV (CC TV )ijk ij ij ij ij ij i ijkv v            . 

1.3.4.2 Setting up the analysis 

We modify our model setup saved to the syntax file TVSFP1.mum by first using the 
Open Existing Model Setup option on the File menu of the TVSFP.ss3 window to 
retrieve the syntax file. Then click on File, Save as to save the model setup in a new 
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file, such as TVSFP3.mum. Next, we change the string in the Title 1 text box on the 
Configuration screen, and select SCHOOL as the Level-3 ID as shown below. We now 
have both level-2 and level-3 IDs selected. 

 

 
 

Keep all the other settings unchanged. Save the changes to the file TVSFP3.mum and 
select the Run option on the Analysis menu to produce the output file TVSFP3.out.  

1.3.4.3 Discussion of results 

Data summary 

The number of observations section clearly shows the hierarchical structure of the 
data. The data contains 1600 students from 135 classes nested in 28 schools. In 
school number 20 (LEVEL 3: 20), the data of 73 students (N1: 73) from 7 (N2: 7) 
classes are present in this data set. 
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Fixed effects estimates 

As shown below, the estimates are not markedly different from the estimates of the 
previous two models. 
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Both the deviance and Akaike information criterion (AIC) are slightly higher than 
the previous model. The SBC is smaller.  

 

  

Random effect estimates 

The estimates for the random part of the model are reported next. 

 

 
 

The estimated level-2 random effect is highly significant ( p  = 0.08), but the level-3 
is not ( p  = 0.06).  
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1.3.4.4 Interpreting the results 

Fit statistics and % variation explained 

The variation of POSTTHKS scores can be explained by individual differences, 
classroom differences and school differences. 

 

For schools, 

 

 
0.05660

100% 3.04%
0.05660 0.07903 1.72652 

 
 

, 

 

while for classrooms 

 

0.07903
100% 4.24%

0.05660 0.07903 1.72652 
 

 
. 

 

As calculated above, the school difference contributes 3.04% to the explanation of 
the total variance in the outcome, and classroom difference contributes 4.24%. The 
rest, 92.72% of the variation, is explained by the student differences.  

Comparison of models 

In Table XXX.6 the estimates of the previous three models and OLS in this chapter 
are summarized. The three-level estimates all lie between the corresponding two 
level-2 estimates. 
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Table XXX.6: Comparison of OLS and mixed model results 
 

 OLS Estimates Mixed Model 

  L-2 model L-3 model 

    L-2 ID: CLASS L-2 ID: SCHOOL 
L-2 ID: CLASS 

L-3 ID: SCHOOL 

intcept 2.361 2.341 2.361 2.355 

  (0.066) (0.092) (0.124) (0.128) 

CC 0.607 0.589 0.652 0.615 

  (0.096) (0.133) (0.178) (0.182) 

TV 0.177 0.120 0.198 0.172 

  (0.094) (0.131) (0.175) (0.179) 

CCxTV -0.323 -0.247 -0.417 -0.351 

  (0.137) (0.189) (0.250) (0.255) 

Deviance  5498.168 5501.438 5491.033 

 AIC   5510.168 5513.438 5505.033 

 SBC  5527.600 5521.431 5514.359 

Number of free parameters 6 6 7 

 

1.3.5 A 3-level random intercept  model including pre-THKS score 

The PRETHKS variable indicates the observed score before implementation of 
intervention. It might have an impact on the POSTTHKS scores. In this section, a 
three-level model including the PRETHKS as predictor is fitted. 

 

1.3.5.1 The model 

The only difference between this model and the previous one is the addition of the 
variable  PRETHKS as a covariate: 
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 0 1 2 3 4

0 0

POSTHKS CC TV (CC TV ) PRETHKS

.

ijk ij ij ij ij ijk

ij i ijkv v

    



     

  
 

 

From the subscripts associated with the coefficients, we note that while CC, TV and 
CCxTV were measured at a classroom level, the pre-intervention score PRETHKS is 
measured on the individual level. Such a variable may also be referred to as a level-
1 predictor, while CC, TV and CCxTV may be called level-2 predictors, covariates, or 
mediating effects. 

1.3.5.2 Setting up the analysis 

The easiest way to set up this model is to modify the model setup in the syntax file 
TVSFP3.mum by first using the Open Existing Model Setup option on the File menu. 
Then click on File, Save as to save the model setup in a new file, such as 
TVSFP4.mum.  

 

 



 
 
 

112 
 

 

Next, we change the string in the Title 1 text box on the Configuration screen. Notice 
that we would like to request Bayes estimates as part of the program output. To do 
so, select means & (co)variances option from the Write Bayes Estimates drop down 
list as shown above.  

 

Click on the Variables tab and select PRETHKS as an additional Explanatory Variable 
by checking the corresponding E check box.  

 

 
 

Save the changes to the file TVSFP4.mum and select the Run option on the Analysis 
menu to produce the output file TVSFP4.out.  

1.3.5.3 Discussion of results 

Fixed effects estimates and descriptive statistics 
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As shown below, the estimated coefficient of PRETHKS is highly significant. The 
estimate of the intercept coefficient decreased because part of the variation in the 
intercept can now be explained by PRETHKS.  

 

 
 

The fit statistics are given below. A comparison of these two three-level examples 
will be given in the next section. 

 

  

Random effect estimates 

The third-level random intercept estimate is not significant at a 5% level of 
significance, which implies that after taking PRETHKS into account, the school 
differences are not significant.  
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1.3.5.4 Interpreting the results 

Estimated outcomes for different groups 

For example, if a typical student who only participated in television intervention had 
a PRETHKS score of 2 (CC = 0; TV = 1; CCxTV = 0), the expected POSTTHKS score is 
calculated as follows: 

 

     00 02 04POSTTHKS TV PRETHKS

1.697+0.17811+2 0.3072

2.48951.

ijk ij ijk    

 


 

ICCs and R square 

ICCs 

The so-called ICC (interclass correlation) measures the proportion of variation in 
the outcome variable between units at the different levels. It is occasionally referred 
to as the cluster effect, and is defined as the ratio of the between-cluster variance to 
the total variance. From the output for the random effects, we have  
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





Level-1: error var = 1.6020

Level-2: class var = 0.0636

Level-3: school var = 0.0258.

 

 

Based on this information, we can calculate the ICCs as shown below. 

 

Similarity of students within the same school:  

 

 
0 0258

0 0153
1 6020 0 0636 0 0258

ICC


  
    

 

 

Similarity of students within the same classrooms (and schools):  

 

 
0 0636 0 0258

0 0529
1 6020 0 0636 0 0258

ICC
  

  
    

 

 

Similarity of classes within the same school:  

 

 
0 0258

0 289
0 0636 0 0258

ICC


  
  

 

R square 

Another way to evaluate the explanation of variation in the outcome is to compute a 
statistic analogous to the familiar 2R  used in multiple linear regression. In a 

multilevel model, however, there is an 2R  for each variance component. Use of 

these statistics is not without problems, however, because the 2R  may at times have 

negative values, and in other cases the addition of explanatory variables can lead to 
an increase rather than a decrease in variance components. The more complex a 
hierarchical model is, the more likely is the occurrence of anomalies in variance-
explained statistics.  
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To calculate the 2R s for different levels of the level-3 model, we first need to get 

the variances for the null model, which is a 3-level model with no covariates. Open 
the file TVSFP4.mum, click on the Variables tab, and uncheck the check boxes of the 
selected Explanatory Variables as shown below.  

 

 
 

Save the setup as TVSFP7.mum and run the model to get the following output of the 
variance/covariance component. 
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The 2R s are calculated as 

 ( 2) (3)

( 2) 0 (3) 0

2 22
2 2 2

1 2 32 2 2
0

ˆ ˆˆ
1 1 1

ˆ ˆ ˆ
p pv vp

v v

R R R
 

  
       

 

where subscript 0 refers to a model with no covariates (i.e., the null model, 
TVSFP7.out) and subscript p refers to a model with p covariates (i.e., the full model, 
TVSFP4.out). The 2R s for different levels are given in Table XXX.7.  

 

Table XXX.7: 2R  values for a set of nested models 

 

level variance null full 2R  
1 (students) 2̂  1.724 1.602 .071 

2 (classrooms) 
( 2)

2ˆ  
.085 .064 .247 

3 (schools) 
( 3)

2ˆ  
.110 .026 .764 

 

In the current example, only the intercept coefficient is allowed to vary randomly 
over classrooms and schools, thus making the calculation of the 2R  relatively 
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straightforward. In the case of models with random slopes, the calculation of 2R  

statistics becomes more difficult. For an extensive discussion of the rationale and 
calculation of 2R  statistics, the user is referred to Snijders & Bosker (2000, pp. 99 – 

109). 

Model fit statistics and comparison of models 

Now, we consider two level-2 models  using the same covariates but different level-
2 IDs: one uses CLASS as level-2 ID, the other uses SCHOOL. The models’ setups 
are given in TVSFP5.mum and TVSFP6.mum. The comparison of estimates is 
summarized in the following table.  

 

Table XXX.8: Comparison of OLS and mixed model results 
 

  
OLS 
Estimates 

Mixed Model 

    L-2 model L-3 model 

    L-2 ID: CLASS L-2 ID: SCHOOL 
L-2 ID: CLASS 

L-3 ID: SCHOOL 

intcept 1.6613 1.6776 1.6952 1.6970 

  (0.0844) (0.0988) (0.1145) (0.1167) 

CC 0.6406 0.6330 0.6601 0.6392 

  (0.0921) (0.1186) (0.1440) (0.1472) 

TV 0.1987 0.1597 0.2024 0.1781 

  (0.0900) (0.1167) (0.1401) (0.1437) 

CCxTV -0.3216 -0.2747 -0.3697 -0.3204 

  (0.1303) (0.1678) (0.2011) (0.2055) 

PRETHKS 0.3252 0.3116 0.3103 0.3072 

  (0.0259) (0.0258) (0.0259) (0.0258) 
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Table XXX.8 (continued) 
 

error variance  1.6030 1.6523 1.6020 

   (0.0589) (0.0589) (0.0589) 

class variance  0.0870  0.0636 

   (0.0277)  (0.0277) 

school variance   0.0372 0.0258 

    (0.0184) (0.0197) 

Deviance  5359.9641 5366.0133 5357.3586 

 AIC   5373.9641 5380.0133 5373.3586 

 SBC  5394.3010 5389.3387 5384.0163 

Number of free parameters 7 7 8 

 

When comparing the deviances, AIC and SBC of the level-3 model with the level-2 
models, we conclude that the three-level model has a better fit to the data. 

1.3.5.5 Residuals 

Level-2 Bayes results 

Returning to the TVSFP4.mum output, click on the Analysis menu of the output 
window or the model set up window, and note that View Level-2 Bayes Results is 
now activated. Select the option to open the level-2 Bayes results. 

 

 
 

Note that the default extension for the level-2 Bayes estimates is .ba2. Part of the 
file is shown below. 
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The representations of these seven columns are given in order below. 

 

o Column 1: level-3 ID, which is school in our example.  

o Column 2: level-2 ID, which refers to classroom. 

o Column 3: number of the observations within level-2 ID, number of students 
within each classroom.  

o Column 4: the number of the empirical Bayes coefficients. 

o Column 5: the empirical Bayes estimate. 

o Column 6: the estimated variance of the Bayes coefficient. 

o Column 7: the name of the associated coefficient as used in the model.  

 

Classroom 407102 has the largest Bayes estimate with a value of 0.38397. When 
considering the class difference, the predicted POSTTHKS score for a student in this 
specific class who only participated in television intervention with a PRETHKS score 
of 2 (CC = 0; TV = 1; CCxTV = 0) is calculated as follows. 

 

       00 2 4POSTTHKS TV PRETHKS

1.697+0.17811+2 0.3072+0.38397

2.87348.

ijk iij ijk u     

 

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Level-3 Bayes results 

Similarly, the level-3 Bayes results can be viewed by clicking on the Analysis, View 
Level-3 Bayes Results.  

 

 
 

Part of the TVSFP.ba3 is shown below. 

 

 
 

The same classroom (ID = 407102) discussed above is nested in school number 407. 
Now,  considering both the class and school differences, the estimated POSTTHKS 
for a student from this classroom who only participated in television intervention 
with a pre-intervention score of 2 (CC = 0; TV = 1; CCxTV = 0) is calculated as 
follows. 
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      0 00 2 4POSTTHKS TV PRETHKS

1.697+0.17811+2 0.3072+0.38397+0.15296

3.02644.

ijk ij iij ijk v v      

 


 

 

 

Confidence intervals for random coefficients 

The Confidence Intervals option on the File, Model-based Graphs menu provides the 
option to display confidence intervals for the empirical Bayes estimates of the 
random effects specified in a given model. This option is now used to examine the 
confidence intervals of the random intercepts for the schools, which represent the 
highest level of the hierarchy in the current example. 

 

Select the Confidence Intervals option on the File, Model-based Graphs menu to 
activate the 95% Conf. Intervals for EB estimates dialog box. Two graphs of the 
confidence intervals for the empirical Bayes estimates of the intercepts at the 
classroom level and school level are obtained by selecting CLASS intcept and 
SCHOOL intcept in the Predictor column before clicking Plot.  

 

 
 

The graph obtained, as shown below, shows that, in general, the range of the 
confidence intervals for the level-3 empirical Bayes estimates of the intercepts is 

0 2 0 2. .( ; ) , and the range for level-2 is about 0 4 0 4. .( ; ) .  
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Figure XXX.14: 95% confidence intervals for level-2 Bayes estimates 
 

The deviations from the estimated population intercept over schools are also 
apparent. Each confidence interval is obtained using the formula 

 

 1 96Empirical Bayes residual . var Empirical Bayes residual . 
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1.4 New 3 level continuous example using a subset of 
Schoenwald data 

1.4.1 The data 

The data set for this example is taken from a study described in Schoenwald & 
Henggeler (2005). Children in the study were assigned to therapists and followed 
across time. In this study, respondents were rated with the Child Behavioral 
Checklist (Achenbach, 1991) at four occasions. The gender of each respondent 
was also recorded.  

 

Although the total number of patients in this study was 1,951, the number of patients 
treated by any single therapist ranged between 1 and 19. A total of 7,127 
measurements were made for all patients over the course of the study. Data for the 
observations of all the variables for the first four patients treated by therapist 
number 18 are shown below in the form of a SuperMix spreadsheet file, named 
cbtot.ss3. 

 

 
 

The variables of interest are: 

o THERAPIS is the therapist ID (446 in total). 

o SID is the patient ID (1951 in total). 
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o CBTOT is the total score of the Child Behavior Checklist. 

o INT is a column of ones, representing an (optional) intercept. 

o VISIT represents the visit number (0, 1, 2, or 3) at which a measurement was 
made. 

o GENF is an indicator variable for gender, and assumes the value 0 for males 
and 1 for females. 

o GVISIT represents the interaction between GENF and VISIT, and is the product 
of GENF and VISIT. 

1.4.2 Exploring the data 

Relationships between variables, and trends over time in repeated measurement 
data, may be conveyed in an informal and simplified visual form via graphical 
displays. SuperMix offers both data-based and model-based graphs. Data-based 
graphing options are accessed via the File, Data-based Graphs option once a 
SuperMix data file (.ss3) is opened, while model-based graphs are available after the 
analysis has been performed, and will be discussed later in this section. 

 

In the case of data-based graphs, we distinguish between three categories: 
univariate, bivariate, and multivariate graphs. Univariate graphs are particularly 
useful to obtain an overview of the characteristics of a single variable. In the 
sections to follow, we use data-based graphs to take a closer look at some of the 
variables in these data. 

1.4.2.1 Univariate graphs 

Histograms 

As a first step, we take a look at the distribution of the total score on the Child 
Behavior Checklist (CBTOT) which is the potential dependent variable in this study. 
While scores such as these are not truly continuous variables, they are often treated 
as if they were. However, like personal income, the distribution of a score often is 
skewed. As a first step, we will take a closer look at the distribution of the intended 
outcome variable CBTOT. To do so, select the Univariate option from the Data-based 
Graphs menu as shown below. 



 
 
 

126 
 

 

 
 

The Univariate plot dialog box appears. Select the variable CBTOT and indicate that 
a Histogram is to be graphed. Note that the number of class intervals shown on the 
histogram is controlled by the Number of class intervals field, which is left at the 
default value of 10 in this case. Click the Plot button to display the histogram. 
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The histogram below shows that the distribution of total scores (CBCTOT) on the 
Child Behavior Checklist (CBC) is markedly asymmetrical. Given the normality 
assumptions used in fitting a 3-level linear multilevel model, it would be 
inappropriate to use CBCTOT in its current state. A transformation of this variable is 
required before it would make a suitable outcome variable for the intended analysis. 

 

 
Figure XXX.15: Histogram of the variable CBCTOT 

Transformation of variables 

Common transformations used in the case of skewed variables include the natural 
logarithm of the variable in question, or the square root of the variable. We opt to 
explore the possibility of using the square root of the total score as outcome. To do 
so, a new variable containing the square root of the current total scores has to be 
created in the SuperMix spreadsheet. Right-click on the column with CBCTOT as 
heading, and select the Insert Column option from the pop-up menu that appears. 
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Select the new column and input the function SQRT(D1) in the formula box as 
shown below. Click the Apply button. Each value of the new variable is the square 
root value of the corresponding value of the variable CBCTOT as shown below. 
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To rename the new variable, right-click again on the column header and select the 
Column Properties option. 

 

 
 

Complete the Header field in the Column Properties dialog box as shown below. 
Also indicate that this is a continuous variable by selecting the Continuous option 
before clicking the OK button. 

 

 
 

Check the distribution of the square root of the total score on the Child Behavior 
Checklist (SQR_CBC) by selecting the Univariate option from the Data-based Graphs 
menu to activate the Univariate plot dialog box. After selecting SQR_CBC by 
checking the appropriate box in the Plot column, select the Histogram option as 
before, and click Plot. 
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The histogram for the variable SQR_CBC is appreciably more symmetric than was 
the case for the original variable CBCTOT, as evident from the histogram shown 
below.  
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Figure XXX.16: Histogram of the variable SQR_CBC 

1.4.2.2 Bivariate graphs 

It is hoped that the total scores of patients would change over time, i.e., with 
successive visits to their therapists. In addition, it is hypothesized that the gender of a 
patient may also have some relationship to the total score of a patient. Bivariate plots 
of possible relationships are a handy tool for the exploration of possible relationships.  

Exploratory graphs 

To explore the relationship between the time since the start of therapy and the square 
root of the total score, select the Data-based Graphs, Exploratory option from the File 
menu to activate the New Graph dialog box. 
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Select the outcome variable SQR_CBC as the Y-variable and VISIT as the X variable. 
Add the variable representing gender, GENF, from the Color field. Doing so will 
lead to the graphs of the gender groups to be displayed in different colors (blue and 
green being the default colors for two groups). Select the patient ID, as denoted by 
the variable SID, as the Filter variable to obtain individual graphs for patients. Click 
OK after completing the fields on this dialog box. 

 

 
 

Graphs for patients with SIDs equal to 973, 790, and 2233 are shown below. These 
are but three of the 1951 graphs created via the graphing specification described 
above. Plotting symbols for each patient are shown at the bottom left of the 
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graphing window, and the legend for gender groups to the right. The slider at the 
bottom of the window is used to move from one graph to another. 

 

For the first patient, with SID equal to 973, a roughly linear decrease in the outcome 
is observed as the visit number increases. This is not the case for patient 790, where 
an almost parabolic curve is observed, or for patient 2233 where an inverted 
parabola seems to be the most obvious line to fit. It can be concluded from these 
graphs that the relationship between SQR_CBC and VISIT differs from patient to 
patient, and moreover that it may not be strictly linear. The possible inclusion of a 
quadratic function of the time of measurement, i.e. VISIT, should be explored. No 
definite trend is immediately apparent for gender groups within the wide variety of 
curves plotted, but the possibility of an interaction between the gender and the 
number of the visit cannot be excluded.  
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Figure XXX.17: Relationship between SQR_CBC and VISIT for selected patients 

Transforming a variable 

To examine the relationship between the outcome and the quadratic value of VISIT, a 
new variable has to be created. This is done in a similar way to adding the square 
root of the total score. First insert a column, then type the appropriate function into 
the formula box as shown below. Click the Apply button. Each value of the new 
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variable is the squared value of the corresponding value of the variable VISIT as 
shown below. 

 

 
 

Right-click on the header of the newly inserted column to activate the Column 
Properties dialog box and enter a variable name such as SQ_VISIT into the Header 
field. Click OK to return to the spreadsheet. 

1.4.2.3 Exploratory graphs 

Remake the bivariate graphs shown previously for SQR_CBC and VISIT, using the 
squared value of VISIT (SQ_VISIT) instead. The completed New Graph dialog box, 
accessed via the Data-based Graphs, Exploratory option, is shown below. Click OK 
to display the graphs for individual patients. 
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Very little change in the shape of the plots is observed in the graphs obtained for the 
three patients considered earlier. To follow up on the possibility of a nonlinear 
relationship between the outcome and the visit number, both of the variables VISIT 
and SQ_VISIT will be included in the first model fitted, where the relationship of 
each with the outcome can be evaluated in the presence of the other. 
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Figure XXX.18: relationship between SQR_CBC and SQ_VISIT for selected patients 

Box-and-whisker plots 

Another bivariate plot of interest is a box-and-whisker plot, which may be used to 
examine the distributions of continuous variables such as for the different values of 
discrete valued predictors. This option, accessed via the Data-based Graphs, 
Bivariate option on the File menu, is now used to take a closer look at the 
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distribution of the transformed outcome variable at different visits, and for the two 
gender groups. 

 

The Bivariate plot dialog box is completed as follows: select the outcome variable 
SQR_CBC as the Y-variable of interest, and the predictor VISIT to be plotted on the 
X-axis. Check the Box and Whisker option, and click Plot. 

 

 
 

In the plot shown below, the box-and-whisker plots for the square root of the 
CBCTOT scores are shown at each of the measurement occasions. Recall that the 
bottom line of a box represents the first quartile ( 1q ), the top line the third quartile 

( 3q ), and the in-between line the median (me). Here, the arithmetic mean is 

represented by a diamond. A decrease in the mean HDRS rating is observed over the 
course of the study. In addition, the larger distances between the extremes of the 
boxes at the later measurement occasions indicate more variability in the 
transformed  CBCTOT scores towards the end of the study.  
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Figure XXX.19: Box-and-whisker plot of SQR_CBC vs. VISIT 
 

When a similar plot is made for the original total score as represented by the 
variable CBCTOT, it is clear that the distributions of the transformed scores, though 
still exhibiting more variability at later visits, are closer to normal for the 
transformed variable (figure below).  

 

 
Figure XXX.20: Box-and-whisker plot of CBCTOT vs. VISIT 
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A box-and-whisker plot of the transformed scores for the two gender groups can 
easily be obtained. Simply close the graph window shown above, deselect VISIT as 
the X-variable and select the indicator of gender GENF instead. Click Plot to obtain 
the box-and-whisker plot shown below. A slightly larger range of scores is observed 
for males (GENF = 0) than for females (GENF = 1).  

 

 
Figure XXX.21: Box-and-whisker plot of SQR_CBC vs. GENF 

 

When this plot is compared to a similar one for the untransformed outcome variable 
CBCTOT, the same tendency towards a less normal distribution is observed, 
particularly with respect to the total scores of male patients. 
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Figure XXX.22: Box-and-whisker plot of CBCTOT vs. GENF 

Bivariate bar charts 

Another bivariate plot that may provide insight is  a plot of gender by the number of 
visits. The Bivariate option on the File, Data-based Graphs menu is again used to 
access the Bivariate plot dialog box. Select VISIT as the Y-variable and GENF as the 
X-variable, and request a bivariate bar chart prior to clicking the Plot button. 
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The bar chart for VISIT vs. GENF shows not only that more males than females are 
present in the data, but also that roughly equal numbers of observations/scores are 
available for the two groups at each of the visits. The pattern in terms of the number 
of observations available at each visit is the same for the two gender groups. 

 

 
Figure XXX.23: Bivariate chart of VISIT vs GENF 

1.4.3 Fitting a growth curve model to the data 

1.4.3.1 The model 

The first model fitted to the data explores the relationship between SQR_CBC and 
the visit number, as represented by the variables VISIT and SQ_VISIT: 

 

0 1 2 0 0SQR_CBC VISIT SQ_VISITijk ijk ijk i ij ijkv v e           

 

In this model, 0  denotes the average expected total score, and 1  and 2  indicate 

the estimated coefficients associated with the fixed part of the model which contains 
the predictor variables VISIT and SQ_VISIT. The random part of the model is 
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represented by 0iv , 0ijv  and ijke , which denote the variation in average total score 

over therapists, between patients (or, in other words, over patients nested within 
therapists) and between measurements at the lowest level of the hierarchy.  

1.4.3.2 Setting up the analysis 

Open the SuperMix spreadsheet cbtot.ss3. The next step is to describe the model to 
be fitted. We use the SuperMix interface to provide the model specifications. From 
the main menu bar, select the File, New Model Setup option.  

 

Select the continuous outcome variable SQR_CBC from the Dependent Variable 
drop-down list box on the Configuration tab. The therapist number THERAPIS and 
respondent identification code SID used to define the levels of the hierarchy are 
specified as Level-3 ID and Level-2 ID respectively by selecting them from the Level-
3 IDs and Level-2 IDs drop-down list boxes. Enter a title for the analysis in the Title 
text boxes. Select the means & (co)variances option from the Write Bayes estimates 
drop-down list box to request the writing of residuals to an external file. In this 
example, default settings for all other options associated with the Configuration 
screen are used. Proceed to the Variables screen by clicking on that tab. 
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The Variables screen is used to specify the fixed and random effects to be included 
in the model. Select the explanatory (fixed) variables using the E check boxes next 
to the variables names in the Available grid at the left of the screen. Note that, as the 
variables are selected, the selected variables are listed in the Explanatory Variables 
grid. After selecting all the explanatory variables, the screen shown below is 
obtained. The Include Intercept check box in the Explanatory Variables grid is 
checked by default, indicating that an intercept term will automatically be included 
in the fixed part of the model.  

 

Next, specify the random effects at levels 2 and 3 of the hierarchy. In this example, 
we want to fit a model with random intercepts at levels 2 and 3. By default, the 
Include Intercept check boxes in both the L-2 Random Effects and L-3 Random 
effects grids are checked. If these boxes are left checked, and no additional random 
effects are indicated using the 2 column in the Available grid to the left, the model 
fitted will be the random-intercepts-only model we intend to use. No further 
changes on this screen are necessary.  
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Before running the analysis, the model specifications have to be saved. Select the 
File, Save As option, and provide a name (cbctot.mum) for the model specification 
file. Run the analysis by selecting the Run option from the Analysis menu. 

1.4.3.3 Discussion of results 

Portions of the output file cbtot.out are shown below.  

 

In the first section of the output file, a description of the hierarchical structure is 
provided. Data from a total of 446 therapists and 1951 patients at 7127 measurement 
occasions were included at levels 3, 2 and 1 of the model. This corresponds to the 
study design described earlier. In addition, a summary of the number of patients and 
measurements nested within each therapist is provided. The therapist with ID3 = 21, 
for example, had 15 patients (N2: 15). These patients were measured at 59 occasions. 
By contrast, therapist 23 had only 1 patient, for whom 4 measurements were made. 

 

 
 

The data summary is followed by descriptive statistics for all the variables included 
in the model. The mean of 6.61867 reported for the outcome SQR_CBC translates to 
a total score of 43.806 on the Child Behavior Checklist. 
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Fixed effects results 

The output describing the estimated fixed effects after convergence is shown next. 
The estimates are shown in the column with heading Estimate, and correspond to the 
coefficients 0 1 3, , ,    in the model specification. From the z-values and 

associated exceedance probabilities, we see that the coefficients associated with 
both the time of measurement (VISIT) and squared value of the time of measurement 
(SQ_VISIT) are highly significant. The significance of the estimate associated with 
SQ_VISIT supports the tentative conclusion made during the exploratory analysis 
that the relationship between score and visit number cannot adequately be described 
by a linear relationship. While the average CBC score is expected to decrease with 
0.94119 units between two successive visits, a smaller increase in score of 0.13671 
is associated with the squared value of the time of measurement. 

 

 

Random effects results 

The output for the random part of the model follows, and is shown in the image 
below. There is significant variation in the average estimated total health 
expenditure at all levels, with the most variation over the patients (level-2), and the 
least variation over therapists (level-3). 
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1.4.3.4 Interpreting the results 

Estimated outcomes for different groups 

A typical patient at the start of the study is expected to have a transformed CBC 
score of 

 

   
0 1 20 00

2

SQR_CBC VISIT SQ_VISIT

7.59245 0.94119(0) 0.13671(0 )

7.59245,

ij ijij       

  


 

 

that is, the estimated intercept. Similar equations for expected transformed scores at 
subsequent measurements (visits) are obtained in the same way: 

 

 2
1VISIT 1:SQR_CBC 7.59245 0.94119(1) 0.13671(1 )

7.59245 0.94119 0.13671

6.78797

ij   

  

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 2
2VISIT 2 :SQR_CBC 7.59245 0.94119(2) 0.13671(2 )

7.59245 1.88238 0.54684

6.25691

ij    

  


 

 

 2
3VISIT 3:SQR_CBC 7.59245 0.94119(3) 0.13671(3 )

7.59245 2.82357 1.23039

5.99927

ij   

  


 

 

The effect of the positive estimate for SQ_VISIT in slowing down the expected 
decrease in CBC scores over successive measurement occasions is clear from the 
equations above: without this estimate, the expected CBC scores at visits 1, 2, and 3 
would have been 6.65126, 5.71007, and 4.76888 respectively. In terms of the actual 
rather than the square root of the CBC scores, the expected scores at the 4 
measurement occasions under the current model are 57.6453, 46.0765, 39.1489, and 
35.9914 respectively. 

Model-based graphs 

Using the Plot Equations for: SQR_CBC dialog box that appears when the File, 
Model-based Graphs, Equations option is selected, we can graphically depict the 
trend in expected average squared score for the predictors VISIT and SQ_VISIT. The 
dialog box below shows the selection of the predictor VISIT, and in the graph 
requested, SQ_VISIT will be fixed at a value of 0. 
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The graph below shows the result obtained when the Plot button is clicked after 
completion of the Plot Equations for: SQR_CBC dialog box as shown above. A 
similar plot for the predictor SQ_VISIT is given directly after. Note that, in the 
second graph, the increase in expected score seems larger than implied by the 
estimate of 0.13671. This is due in part to the difference in the ranges of the two 
predictors, as reflected in the tick marks on the X-axes of the graphs. 
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Figure XXX.24: Plot of SQR_CBC vs. VISIT 

 

 
Figure XXX.25: Plot of SQR_CBC vs. SQ_VISIT 
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Fit statistics and ICC 

From the output for the random part of the model it is clear that there is significant 
variation in the average estimated total health expenditure at all levels, with the 
most variation over the patients (level-2), and the least variation over therapists 
(level-3). 

 

An estimate of the percentage of variation in the outcome at a patient level, for 
example, is obtained as 

 
3.08097

100% 51.32%
0.58201 3.08097 2.34083

 
 

 

 

indicating that 51.32% of the total variance in scores is at the patient level. In 
contrast, 

 
0.58201

100% 9.69%
0.58201 3.08097 2.34083

 
 

 

 

is at the therapist level, with the remainder over measurements nested within 
patients. 

1.4.4 Fitting a random intercept model with 3 predictors and interaction 
term to the data 

1.4.4.1 The model 

From the exploratory analysis, we are aware of a possibly nonlinear relationship 
between the transformed outcome variable SQR_CBC and the visit number, as 
represented by the variables VISIT and SQ_VISIT. Differences in the distributions of 
the transformed scores of the two gender groups also lead us to suspect that the 
outcome may depend to some extent on the gender of the patient. The possibility of 
an interaction between the time elapsed since the start of the study, as represented 
by VISIT and SQ_VISIT, and the gender of a patient cannot be ruled out.  
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The model considered in this section uses the participant's gender, visit number, 
squared value of the visit number, and the interaction between visit number and 
gender (represented by the variable GVISIT in the data spreadsheet) to predict the 
square root of the total score on the Child Behavior Checklist. This second order 
growth curve with gender and the interaction term as covariates can be expressed as 
follows: 

 

0 1 2 3 4

0 0

SQR_CBC GENF VISIT SQ_VISIT GENF *VISITijk ij ijk ijk ij ijk

i ij ijkv v e

            

  
 

As before, 0  denotes the average expected total score, 1 2 4, , ,    indicate the 

estimated coefficients associated with the fixed part of the model, and 0iv , 0ijv  and 

ijke  represent the random part of the model.  

1.4.4.2 Setting up the analysis 

The SuperMix spreadsheet cbtot.ss3 and the model specification file cbtot.mum 
discussed in the previous example are used a point of departure. With the model 
specification file open, click on the Variables tab of the Model Setup window. Add 
the predictors GENF and GVISIT to the model by checking the boxes next to these 
variables in the E column, as shown below. 
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Save the modified model specification file, then select the Run option from the 
Analysis menu to perform the analysis. 

1.4.4.3 Discussion of results  

Fixed effects results 

The maximum likelihood estimates of the coefficients in the fixed part of the model 
are shown below. The statistical significance of all the effects confirm our suspicion 
that the CBC scores measured over time not only depend on the time of 
measurement and the squared value thereof, but also on the gender of the patient. A 
significant interaction between gender and the time of measurement is also 
observed. Recall that for male patients GENF was coded 0, and for females GENF 
was assigned a value of 1. The positive estimate of 0.28977 for the effect of gender 
indicates that males tended to have a lower score on average than females: the 
expected average male score is 0.28977 units lower on the transformed CBC scores 
than for females. This effect is offset by the negative estimate of the interaction 
effect. For males, the interaction term GVISIT assumes the value 0, but for females 
GVISIT is equal to 0, 1, 2, and 3 respectively at the 4 measurement occasions. The 
transformed score of a female patient is thus expected to be 0.10034 units lower at 
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the second visit than the score of a male patient, or a female patient at the beginning 
of the study.  

 

 

Random effects results 

The output for the random part of the model is given next.  
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As before, most variation in scores is found at a patient level, and the least variation 
at the therapist level. The estimated percentages of variation in outcome at patient 
and therapist level are  

 
3.08224

100% 51.39%
0.57846 3.08224 2.33647

 
 

 

and 

0.57846
100% 9.65%

0.57846 3.08224 2.33647
 

 
 

 

respectively. When compared to the similar percentages for the growth curve model, 
changes observed are negligible. The addition of the variables GENF and GVISIT did 
not contribute significantly to the explanation of remaining variation in the outcome 
at the various levels of the model. 

1.4.4.4 Interpretation of the results  

Estimated outcomes for different groups 

For a typical patient, the expected CBC score can be calculated as 

 

     
0 1 2 3 4SQR_CBC GENF VISIT SQ_VISIT GVISIT

7.49255 0.28977 GENF 0.90730 VISIT

0.13703 SQ_VISIT 0.10034 GVISIT .

ij ijk ijk ijkijk

ij ijk

ijk ijk

            

    

   

 

 

For male patients GENF = 0, and thus the formula used to predict their CBC scores 
reduces to 
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SQR_CBC 7.49255 0.28977 (0) 0.90730 VISIT

0.13703 SQ_VISIT 0.10034 (0)

7.49255 0.90730 VISIT 0.13703 SQ_VISIT .

ijkijk

ijk

ijk ijk

    

   

    

 

For female patients GENF = 1, and thus the formula used to predict their CBC scores 
can be expressed as 

 

SQR_CBC 7.49255 0.28977 (1) 0.90730 VISIT

0.13703 SQ_VISIT 0.10034 GVISIT

7.78232 0.90730 VISIT 0.13703 SQ_VISIT 0.10034 GVISIT .

ijkijk

ijk ijk

ijk ijk ijk

    

   

      
 

Table XXX.9 below shows the expected square roots of CBC scores for the various 
groups formed by the gender groups and interaction term at all measurement 
occasions. In Table XXX.10, the same expected scores are given in the scale of the 
original total score on the Child Behavioral Checklist. The initial impression, based 
on the positive coefficient of GENF, that females had higher expected CBC scores 
than males, seems to hold at the onset of the study. However, these tables show that, 
after the effects of the other variables are also taken into account, females are likely 
to have a slightly lower score than males at the end of the study period.  

 

Table XXX.9: Expected square root of CBC scores 
 

Visit Gender 

0 1 2 3 

Male 7.4926 6.7223 6.2261 6.0039 

Female 7.7823 6.9117 6.3152 5.9927 
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Table XXX.10: Expected CBC scores in original scale 
 

Visit Gender 

0 1 2 3 

Male 56.1383 45.1890 38.7639 36.0471 

Female 60.5645 47.7717 39.8813 35.9121 

 

The results in these tables can also be depicted graphically using the File, Model-
based Graphs menu. This menu offers three options, namely equation modeling, 
residual plots and confidence intervals for random effects.  

Equation modeling 

To plot the trends in CBC scores for gender groups over successive visits, make sure 
the Model Setup window is activated by clicking on it before select the Equations 
option from the File, Model-based Graphs menu.  

 

 
 



 
 
 

159 
 

This activates the Plot Equations for: SQR_CBC dialog box. Select VISIT as the 
predictor, and request marking by gender as shown in the image below. Note that, 
by default, remaining predictors are fixed at 0. Click Plot to display the graphing 
window. 

 

 
Figure XXX.26: Plot of SQR_CBC vs. VISIT for gender groups 

 

By default, graphs using a two-category marking variable such as GENF will be 
displayed using blue and green to indicate the categories. To make the distinction 
between the groups of interest more clear, and create a graph that can be included in 
a report or paper to be printed in black and white, the plotting symbols can be 
changed. Here, we opt to change the line for female patients to a black, dotted line. 
Double-click on the line for this group in the legend box shown at the top right of 
the graph to activate the Plot Parameters dialog box. Next, click the Line Attributes 
button to load the Line Parameters dialog box.  

 

Change the line style to dotted using the Style drop-down list box, and select black 
from the Color drop-down list box. Click OK on both the Line Parameters and Plot 
Parameters dialog boxes to obtain the final graph shown below.  
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Figure XXX.27: Modified plot of SQR_CBC vs. VISIT for gender groups 

 

The predicted decrease in CBC score echoes the results of the maximum likelihood 
estimation of the fixed effects, where a negative coefficient of -0.9073 was reported 
for the predictor VISIT. While the predicted intercept for males at the beginning of 
the study is approximately 7.5 as indicated in the graph at the top-left of the 
graphing window, the predicted intercept for the same group has decreased to 
approximately 4.75 by the final visit. This is lower than reported in Table XXX.10, 
where calculations showed an expected CBC score of 6.00 for males by the final 
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visit. The reason for this difference can be found in the formula used to produce the 
graph: recall that all remaining predictors were fixed to a value of 0. Whereas the 
result for males at the final visit shown in Table XXX.10 was based on the 
calculation 

 

SQR_CBC 7.49255 0.28977 (0) 0.90730 VISIT

0.13703 SQ_VISIT 0.10034 (0)

7.49255 0.90730 VISIT 0.13703 SQ_VISIT ,

ijkijk

ijk

ijk ijk

    

   

    

 

 

the line shown for this group in the graph above is based on the formula 

 

SQR_CBC 7.49255 0.28977 (0) 0.90730 VISIT .ijkijk       

 

As a result, the predicted outcome shown in the graph for males at the end of the 
study will be 0 13703 9 1 2333( )( ). .  units lower than reported in Table XXX.10. 
This difference underlines the fact that care should be taken when selecting the 
treatment for remaining predictors in the model. In this case, both SQ_VISIT and 
GVISIT can assume the value of 0, and thus using the remaining predictors fixed at 
zero option is permissible. In cases where predictors cannot assume a value of zero, 
the better choice would be to fix remaining predictors at their mean values instead 
when completing the Plot Equations for: dialog box. 

Confidence intervals for random coefficients 

The Confidence Intervals option on the File, Model-based Graphs menu provides the 
option to display confidence intervals for the empirical Bayes estimates of the 
random effects specified in a given model. This option is now used to examine the 
confidence intervals of the random intercepts for the therapists, who represent the 
highest level of the hierarchy in the current example. 

 

Select the Confidence Intervals option on the File, Model-based Graphs menu to 
activate the 95% Conf. Intervals for EB estimates dialog box. A simple graph of the 
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confidence intervals for the empirical Bayes estimates of the intercepts at the 
therapist level is obtained by selecting THERAPIST Intcept in the Predictor column 
before clicking Plot. Note that it is also possible to select both a grouping and 
marking variable to be used in the graph. 

 

 
 

The graph obtained, as seen below, shows that, in general, the range of the 
confidence intervals for the level-3 empirical Bayes estimates of the intercepts is 

2 2( ; ) . The deviations from the estimated population intercept over therapists are 
also apparent. Each confidence interval is obtained using  

 

 1 96Empirical Bayes residuals . var Empirical Bayes residuals . 
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Figure XXX.28: 95% confidence intervals for level-3 units 

Fit statistics 

Recall that for the growth curve model the following indices were obtained: 

 

o Log Likelihood:   -14946.6236 

o -2 Log Likelihood (Deviance):  29893.2473 

o Akaike's Information Criterion:  29905.2473 

o Schwarz's Bayesian Criterion:  29929.8492 

o Number of free parameters:  6 

 

When the deviances of the two models are compared, a 2 -statistic of 29893.2473 
– 29882.6732 = 10.57 with 8 – 6 = 2 degrees of freedom is obtained. This indicates 
that the current model fits the data better than the growth curve model. The AIC 
decreased from 29905.2473 to 29898.6732, and also favors the use of the current 
model. The SBC, however, increased slightly, from 29929.8492 to 29931.4757, and 
thus favors the growth curve model previously fitted as the more parsimonious. 
Note, however, that the changes in all three criteria are rather small. 
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1.4.4.5 Residuals 

Residual plots 

The Residuals option on the File, Model-based Graphs menu is used to examine the 
residuals obtained for a fitted model. It is useful for examining the fit of the model, 
and also as a check for possible distributional assumption violations. As residuals 
are defined as the difference between the observed and predicted outcomes, trends 
in residuals, for example over the course of a study in a longitudinal data set, may 
indicate that an important predictor was not included in the model fitted to the data. 

 

Select the Residuals option on the File, Model-based Graphs menu to activate the 
Plot of Residuals dialog box. To simultaneously check for any differences in 
residuals for the gender groups, select GENF as marking variable. Opt to create an 
unstandardized plot of the residuals by selecting the Unstandardized Plot option 
rather than the default Standardized Plot option. Click Plot. 

 

 
 

The graph below shows the residuals for the gender groups in the default colors of 
blue and green. To make the distinction between the groups more clear, click on the 
plotting symbol for the female group in the legend box. 
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Figure XXX.29: Level-1 residual plot by gender group 

 

The Plot Parameters dialog box appears. Change the Shape of the symbol to "Up 
Triangle," adjust the Size to 3 and change the display Color to black as shown 
below. Click OK when done. 
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Click on the symbol for the male group next, and change the parameters for this 
group to those shown in the dialog box below. Click OK to return to the graphing 
window. 

 

 
 

The final plot is shown below. The residuals are clustered reasonably symmetrically 
around the 0 tick mark on the Y-axis, and no gender pattern can be discerned for the 
larger residuals. A single residual, for a male respondent, has a value larger than 10. 
This potential outlier can be identified using the Data option on the Plot Parameters 
dialog box (see above). 
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Figure XXX.30: Modified level-1 residual plot by gender group 

1.4.5 Fitting a random intercepts and slopes model 

1.4.5.1 The model 

The graphs obtained during the exploratory analysis of the CBC data showed that the 
change in total CBC score over the course of the study differed from patient to 
patient. Because of this, the models fitted in Sections XXX.2 and XXX.3 allowed 
for the intercepts to vary randomly at both patient and therapist level. In effect, we 
assumed that each patient may have a different starting point. These models 
indicated a statistically significant relationship between the observed CBC score and 
the measurement occasion. To test whether there is significant variation in the way 
individual patients' scores change over the study period, a model in which both 
intercepts and slopes of the predictor VISIT are allowed to vary randomly can be 
used.  

 

The model can be formulated as 

 

0 1 2 3 4

0 1 0 1

SQR_CBC GENF VISIT SQ_VISIT GENF *VISIT

( *VISIT ) ( VISIT )
ijk ij ijk ijk ij ijk

i i ijk ij ij ijk ijkv v v v e

            

    
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At level 2, two random coefficients are now included: 0ijv  represents the random 

intercept and 1ijv  the random coefficient for the slope of the predictor VISIT. The 

random coefficients 0iv  and 1iv  serve the same purpose at level 3 (the therapist 

level) of the model.  

1.4.5.2 Setting up the analysis 

Again, we use the SuperMix spreadsheet cbtot.ss3 and the model specification file 
cbtot.mum discussed in the previous example as the starting point. With the model 
specification file open, click on the Variables tab of the Model Setup window. Add 
random coefficients for the predictor VISIT to levels 2 and 3 of the model by 
checking the boxes next to these variables in the 2 and 3 column, as shown below. 
Save the changes to the model specification file, using the File, Save option to 
overwrite the previous specification file or the File, Save as option to assign a new 
filename. Click Run on the Analysis menu to perform the analysis.  
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1.4.5.3 Discussion of results  

Partial output is given below. We focus on those parts of the output that differ from 
the output obtained for the previous analysis, and conclude with a discussion of the 
additional output files containing the empirical Bayes residuals.  

Fixed effects results 

The inclusion of random VISIT slopes at levels 2 and 3 of the hierarchy has very 
little impact the estimated fixed coefficients. Results for the fixed part are shown 
below.  

 

 

Random effects results 

Turning to the estimated coefficients in the random part of the model, we note a 
change in the between measurement (level-1) variation, which has decreased from 
2.33647 to 1.88939. This illustrates that the addition of a random coefficient at any 
level of a model can affect the random effect(s) at another level.  
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At levels 2 and 3 we find evidence of significant variation in the VISIT slopes. While 
not of the same magnitude as the intercept variation, it is clear that it is more 
realistic to allow the slopes to vary from patient to patient, and from therapist to 
therapist, than to assume that the VISIT slope can be described adequately by a 
common fixed effect as was done in the previous model.  

1.4.5.4 Interpreting the results  

Fit statistics and ICC 

Model fit 

When the measures of fit are compared to those of the random-intercepts-only 
model, it becomes clear that the current model fits the data better. Recall that for the 
random intercepts model the following fit measures were obtained: 

o Log likelihood:    -14941.3366 

o -2 log Likelihood (Deviance):    29882.6732 

o Akaike’s Information Criterion:  29898.6732 

o Schwarz’s Bayesian Criterion:  29931.4757 

o Number of free parameters:   8 
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While four more parameters had to be estimated in the random intercepts and slopes 
model, the deviance decreased significantly. The 2 -statistic for comparing these 
models is 29882.6732 – 29658.6022 = 223.9185, with 4 degrees of freedom. The 
improved fit of the current model is also clear from the other fit measures: both the 
AIC and the SBC clearly favor the current model, and have decreased substantially 
from those reported for the random-intercepts-only model.  

Percentage variation explained 

To take a closer look at the amount of variation explained at the levels of the 
hierarchy, the total variation at each level has to be calculated. At level 3, we have 
three variance/covariance components to take into account. Recall that the model 
included two random effects, namely 0iv  and 1( )i ijkv VISIT . The total variation at this 

level follows as 

 

0 1

0 1 0 1

2
0 1 0 1

2

( 3) var( ( ))

var( ) var( ( )) cov( , ( ))

var( ) ( ) var( ) 2( ) cov( , )

0.58870 0.03869( ) 2(0.03108)( )

0.58870 0.03

i i ijk

i i ijk i i ijk

i ijk i ijk i i

ijk ijk

Var level v v VISIT

v v VISIT v v VISIT

v VISIT v VISIT v v

VISIT VISIT

  

  

  

  

  2869( ) 0.06216( )ijk ijkVISIT VISIT

 

 

At level 2, the total variation can be expressed in similar fashion as 

 

0 1

2
0 1 0 1

2

( 2) var( ( ))

var( ) ( ) var( ) 2( ) cov( , )

3.04361 0.23823( ) 0.2297( )

ij ij ijk

ij ijk ij ijk ij ij

ijk ijk

Var level u u VISIT

u VISIT u VISIT u u

VISIT VISIT

  

  

  
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The total variation in the model is 

 

2

var( 1) var( 2) var( 3)

5.5217 0.27692( ) 0.29186( )ijk ijk

Total Var level level level

VISIT VISIT

     

  
 

 

The variation at the higher levels and, consequently, the total variation are a 
function of the measurement occasion, as represented by the predictor VISIT. For 
example, at the start of the study we find that the total variation is equal to 5.5217, 
with 0.58870 at level 3 and 3.04361 at level 2. This indicates that at the time of the 
first visit,  

 

0.58870
100 10.66%

5.5217
   

 

of the total variation explained by this model is at a therapist level. By the end of the 
study, VISIT assumes a value of 3, and thus the total variation is equal to 7.1384. The 
total variation at the therapist level at the last measurement occasion is 0.75043, and 
thus the percentage of variation at therapist level at the end of the study is 

 

 

0.75043
100 10.51%.

7.1384
   

 

At a patient level, the corresponding percentages of variation at the first and last 
visit are 

 

3.04361
100 55.12%.

5.5217
   
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and 

 

4.49858
100 63.02%

7.1384
   

 

respectively. While the total variation explained at a therapist level declines over 
visits, there is an increase of approximately the same size in the total variation 
explained at a patient level over visits. The variation over patients is consistently 
much higher than over therapists or over measurements nested within patients. 
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THIS IS INCOMPLETE STILL. 

 


